Biotics 4.0

Getting Started Guide

August 25, 2005
Version 0.5
Prepared by

NatureServe

Arlington, VA

                                                                                     United States                                                                   


                                      
[image: image1.png]v,

NatureServe





41
Introduction


52
Biotics Tracker


52.1
Biotics 4 Tracker Overview


52.1.1
Main Window


62.1.2
Detail Window


62.1.3
Subject Areas


82.1.4
Welcome Screen


102.2
Creating Records


102.2.1
Create Element Tracking Records


112.2.2
Create Source Features, Element Occurrences, Managed Areas, Sites


112.2.3
Create Records in Other Subject Areas


122.3
Finding Records


122.3.1
Overview of Find Windows


122.3.2
Selecting Search Criteria


132.3.3
Default Settings


142.3.4
Common Features of Find Windows


142.3.5
Managing Searches and Settings


162.4
Other Basic Tasks


162.4.1
Delete Records


172.4.2
Copying between Individual Fields


182.4.3
Copying Text from Other Applications


182.5
Working Lists


192.5.1
Opening Records from a Working List


202.5.2
Working List Menu Items


212.5.3
Working List Properties


232.5.4
Working List User Options


242.6
Navigation between Records in Biotics Tracker


242.6.1
General Principles and Specific Rules


252.6.2
Navigation Roadmap


402.7
Keystroke Navigation within Records


412.8
Record Copy Functionality


412.8.1
Deep Copy


432.8.2
Shallow Copy


452.8.3
Field copy rules for EGT, ENT, and EST and their related references.


472.8.4
References copied for different types of element records


492.9
Reparenting Element Occurrence Records


492.9.1
Procedure


522.9.2
Points to Remember


532.10
Higher Classification (for Central Users)


532.11
Lineage Tracking (for Central Users)


543
Biotics Mapper


543.1
Creating Features


543.1.1
Create a New Element Occurrence Representation with a single Source Feature


553.1.2
Create a Source Point Feature/EO Rep using X,Y Coordinates


563.1.3
Using Copy Theme to create a Source Feature


573.1.4
Create an EO Rep comprised of Multiple Sources


593.1.6
Create a Parent-EO


593.1.7
Create a Source Line Feature Following the Outline of an Existing Polygon


603.1.8
Create a Source Polygon Feature Adjacent to and In between Two Existing Features


603.1.9
Create a Duplicate Source Feature From an Existing Source Feature


613.1.10
Create a Polygon Source Feature from a Buffered Line


623.2
Deleting Features


623.2.1
Delete an EO Representation


623.2.2
Delete a Source Feature


643.3
Editing Features


643.3.1
Move an EO Representation with a Point Source Feature


643.3.2
Edit EO Reps by editing the Polygon or Line Source Features


653.3.3
Replace a Source Feature with a New Shape of the Same Feature Type


663.3.4
Replace a Source Feature with a Source Feature of Another Feature Type


673.3.5
Add New Source Feature(s) to an Existing EO Rep


673.3.6
Remove Source Feature(s) from an Existing EO Rep


683.3.7
Cut a Hole in a Source Polygon Feature Using an Existing Feature


683.3.8
Replace a Polygon with a Single Polygon Created from Two Polygons in a Copy Theme


693.3.9
Edit a Boundary Shared Between Adjacent or Identical Source Polygon Features


713.4
Working with Managed Areas and Sites


713.4.1
Create a multi-ringed Managed Area or Site by digitizing on screen


713.4.2
Create a multi-ringed Managed Area or Site using a Copy Theme


723.4.3
Add a New Tract to an Existing Managed Area or Site


723.4.4
Remove a Tract from a Multi-ringed Managed Area or Site


733.4.5
Remove a Tract from a Multi-Ringed Managed Area or Site and Add it to Another existing MA or Site


743.5
Use a Digitizing Tablet with Biotics Mapper


764
Biotics Administrator


764.1
Extensibility:  The “Optional Fields” of Biotics Tracker


784.2
Audit Tracking


784.2.1
Record Maintenance


784.2.2
Attribute Maintenance


795
Biotics Exchanger




1 Introduction

Biotics includes four primary applications, described below.  Each application provides a windows interface and manages data stored within a common Oracle database.

Tracker
Provides data management capabilities for all of the tabular data ported from BCD and a number of new methodological enhancements. 

Mapper
Provides spatial data management capabilities through a custom ArcView GIS interface.  Supports the spatial EO methodology. 

Administrator
Interface for managing security, system options, and extensibility.

Exchanger
Utilities for data import/export and bi-directional data exchange.

2 Biotics Tracker

2.1 Biotics 4 Tracker Overview

Biotics 4 Tracker is a customized information management system designed to support the latest developments in the Natural Heritage Methodology used by NatureServe. It allows the entry and management of data related to Elements of biological diversity, Element Groups, Element Occurrences (EOs), Source Features, Managed Areas (MAs), Conservation Sites (Sites), Scientific Names, References, and Contacts.  It also provides seamless access to spatial representations of EOs, MAs, and Sites in Biotics 4 Mapper and displays the spatial attributes calculated by that application.

2.1.1 Main Window

When the user logs on to the application, a Main Window opens from which the user can access data records. Closing the main window closes the application.
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Detail Window

This is the term for the window containing any type of record.  It opens in front of the main application window and can be closed without ending the application session.  Multiple detail windows can be open at the same time. 
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2.1.2 Subject Areas

Subject Areas provide the organizing principle for data entry and retrieval in Biotics Tracker. In each subject area, the user may create and edit one or more specific types of records, may search for records using a Find tool customized for that subject area (see section 2.3), and may save the records retrieved in searches as a Working List (see section 2.5).

The subject areas are Element, Element Group, Element Occurrence, Source Feature, Managed Area, Site, Scientific Name, Reference, and Contact. The two other windows that open from the View menu—Classification and USFS Ecoregions—function much like the subject areas except that (1) it is not possible to create a Working List of records in those windows, and (2) they open on top of the main Biotics Tracker window, rather than in it. 

A subject area is selected by choosing it from the View menu on the main window of Biotics Tracker, or by choosing it in the Welcome Screen (see section 2.1.4). 

To switch from one subject area to another:

· Select View on the main window’s menu bar using the mouse or Alt-V. (A check mark appears next to the current subject area.)

· Highlight an item in the dropdown list with the mouse or Up-Down arrow keys.

· Click mouse or hit Enter. 

In most cases, a subject area or view is synonymous with a single type of record, but in some cases, multiple types of records may be accessed. The following table shows the record types that can be created or accessed directly in each subject area or view:

	Subject Area/View
	Record type

	Element
	Element Tracking (global, national, and subnational)

Element Ranking (global, national, and subnational)

Characterization (global, national, subnational, and local)

Element Management

EO Specifications

EO Rank Specifications

Element References

Element Site intersection

Element Ecoregion intersection



	Element Group
	Element Group

	Element Occurrence
	Element Occurrence*

EO Ecoregion intersection

	Source Feature
	Source Feature*

	Managed Area
	Managed Area

	Site
	Site

	Scientific Name
	Scientific Name

	Reference
	Reference

	Contact
	Contact

	Classification
	Kingdom

Phylum

Class

Order

Family

Genus

System

Level 1

Level 2

Level 3

Level 4

Level 5

Alliance

Alliance Ecoregion intersection


	USFS Ecoregion
	Domain

Division

Province

Section

Subsection


 *In installations that use Biotics Mapper, tabular records for Source Feature and Element Occurrence cannot be created manually in Biotics Tracker. The Source Feature and EO must be created using Biotics Mapper before the corresponding tabular records can be accessed in Biotics Tracker.

Since a Subject Area view occupies the main window, only one Subject Area is visible at a time. The Classification and USFS Ecoregion windows, in contrast, can be open at the same time as the main window and as each other. In addition, detail windows of records retrieved from two or more different subject areas may be open at the same time.

When a user logs into Biotics Tracker, the view that is presented depends on how that user has set his or her Startup Options.  These options are accessed under the Tools menu. If “Open last working list at startup” is selected, the application will open to the subject area containing the last saved working list the user viewed prior to closing the application. If that option is not selected, the view will default to the Element subject area every time the application is opened.
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2.1.3 Welcome Screen

The window titled “Welcome to Biotics Tracker” is an optional feature designed to help users navigate to different subject areas and quickly begin to create or find records after logging into Biotics Tracker.  As a personal option, each user can specify whether or not the Welcome Screen will appear when the application opens.  As they become familiar with the menu and button controls in Biotics Tracker, users may wish to turn off this feature.
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The icons on the tab labeled “New” let you immediately begin to create a new record in the chosen Subject Area. Those on the tab labeled “Existing” open a Find window in the chosen Subject Area so that you can search for an existing record.  The Welcome Screen closes automatically after each use.

To see the Welcome Screen at startup:

· Select Tools – Options… on the main window menu bar.

· Check the box on the Startup tab labeled “Display welcome screen at startup” and chose OK.

To prevent the Welcome Screen from appearing at startup:

· Select Tools – Options… on the main window menu bar.

· Uncheck the box on the Startup tab labeled “Display welcome screen at startup” and chose OK.

To open the Welcome Screen at any time:

Select View – Welcome… on the main window menu.

Note that Classification and USFS Ecoregion records cannot be created or opened from the Welcome Screen.  To access these windows, use the View menu item.

Also note that selecting “Element” on the New tab will default to the creation of an Element Global Tracking record.  Selecting “Element” on the Existing tab allows the user to find an Element Tracking record at any geographic level.

2.2 Creating Records

2.2.1 Create Element Tracking Records

To add a new element to your database, at least one scientific name record for that element has to exist in the SCIENTIFIC_NAME table. If the Subnational Scientific Name (SNAME in BCD) differs from the Global Scientific Name (GNAME), both of those name records must be in the database. Before adding a scientific name record, always check to see if it is already in your database. Since all names used for any element in Central Biotics were included in your SCIENTIFIC_NAME table at the time your data were converted, chances are the name is already there.

In Biotics, the ET record is divided into global, national, subnational records. EO records link to the subnational-level record. You must create the EGT-ENT-EST set. You cannot create just a new EST. 

Add a New Element to the Database 

1. First, determine whether the scientific name for the new element is in your database:

a. Go to the Scientific Name view. 

b. Open the Find Scientific Name window.

c. Search for the name. The search is not case sensitive.

2. If you don't find the name, you have to create a new Scientific Name record before you can create a new EGT record (steps 3 – 8). If you do find the name, close the Find window and skip to step 9 below.

3. To create a new scientific name record, select the New button on the Find window and choose the Name Type.

4. Enter your name in the Scientific Name field.  It will automatically be in italics. 

5. Select a Name Category and Classification Level.  Default values are always filled in because these fields are non-nullable. The list of dropdown values differs depending on whether you previously selected Botanical, Zoological, or Ecological as the name type.

6. Go to the References tab to fill in a reference for this name.  Click the dot-dot-dot button next to the grid to open the Find Reference window. (You may need to add a reference record to your database as well. )  Filling in the reference here will save you work in the EGT.

7. Designate this reference as "Primary" to clicking in the checkbox. You may also indicate that the reference is the original publication of the name if applicable.

8. Save and close the Scientific Name record.

9. Switch to the Element view.

10. Select File - New - Element Global Tracking.  The Find Scientific Name window opens.  Note: If you click on the down arrow next to the icon, you get the same cascading menu as with File - New (Element Global Tracking, Element National Tracking, Element Subnational Tracking). If you click on the icon itself, the application "assumes" you are creating a global record

11. In the Find Scientific Name window, search for the name and click OK. A new EGT record opens.

12. Note that the name you selected is filled in on the Identifiers tab in two places: the Global Scientific Name and the Name Used in Concept Reference.

13. Note that the Reference you designated as "primary" in the Scientific Name record appears in two places: Primary Name Reference Citation and Concept Reference.

14. Select a value from the Classification Status dropdown. Select "Standard" if you have contacted the applicable NatureServe Central Science department and gotten the Concept Reference and Scientific Name information; otherwise, select "Nonstandard."  You have now entered all the information required to save an EGT.  ELCODE is not required, but may be entered if you have that information.  Save the EGT.

15. From the menu in the EGT window, select File - New - Element National Tracking.

16. In the ENT, select your nation from the Nation dropdown.  That is the only field you have to fill in to save the record. The National Scientific Name is inherited from the global record.

17. After saving the ENT, select File - New- Element Subnational Tracking. The Subnational Scientific Name is inherited from the ENT but can be changed in the EST  (click the dot-dot-dot and search for the name you want.

18. In the EST, select your state or province from the Subnation dropdown. You can now save the EST record or add more data.

2.2.2 Create Source Features, Element Occurrences, Managed Areas, Sites

Source Feature and Element Occurrence records may only be created in Biotics Mapper.  Managed Area and Site records may be created in either Mapper or Tracker.  See on-line help for details.

2.2.3 Create Records in Other Subject Areas

· Scientific Name:  See steps 1-8 in section 2.2.1.

· Reference: In Reference view, select File – New from menu or “New” icon. Enter a Reference Code and a Full Citation (required fields) and any other available data. Save record.

· Element Group: In Element Group view, select File – New from menu or “New” icon. Enter a Group Name, Group Type, and Group Member Type (required fields) and any other available data. Save record.

· Contact: In Contact view, select File – New from menu or “New” icon. Enter a Contact Category and Individual Name or Institution Name (required fields) and any other available data. Save record.

2.3 Finding Records

2.3.1 Overview of Find Windows

A customized Find window exists for every subject area in Tracker. The window contains fields identified as being the data attributes most frequently used or needed for finding records in a particular subject area. Only these preselected fields are available in searches conducted from the Find window.  The Query Builder tool allows users to perform searches based on data in other fields.

A Find window can be opened from the application’s main window by selecting Tools – Find on the menu, by clicking the Find icon ([image: image6.bmp]), or by using Ctrl-F or Alt-T-F. It can also be opened in the same ways from inside every type of detail window except those for the intersection files (files that link one type of record to records from another subject area):  Element References, Element/Site, Element Ecoregion, EO Ecoregion, and Alliance Ecoregion. The subject area of the Find window that opens is determined by the View in the main window or the type of record in the detail window.

Find windows have three basic uses in Biotics Tracker, depending on the point from which they are opened: 

1. When a Find window is opened from the main window or a detail window menu or tool bar, it is used for searching for one or more records to be viewed, edited, or added to a Working List.

2. When a Find window is opened by selecting a button with three ellipses ([image: image7.bmp]) inside a detail window, it is used for searching for one or more records to be linked to the record being edited. The subject area of the Find window that opens is determined by the type of data that is being entered in the field.

3. During a record copy operation, the Find window opens to allow the user to search for the record he or she wishes to copy.

2.3.2 Selecting Search Criteria
Most Find windows contain more than one type of field in which to enter or select criteria:

· Radio buttons: If applicable, select the appropriate radio button(s) for your search. Only one radio button in a group box may be selected at a time.  In some cases, selection of a radio button enables or disables certain other fields on the window.

· Check boxes: If applicable, enter or remove checks in check boxes to select search alternatives (for example, in the Find Element window, to determine the geographic level of the records returned in the search). Unlike radio buttons, more than one check box may be checked at the same time in the same group box.

· Text to search for: Enter any text string (may include numbers).  Text searches are case-insensitive.  Before searching, the proper value for “Comparison” must be chosen from the dropdown menu. The following are the choices:

a. Contains will return records with the text string anywhere in the field(s) being searched.

b. Exact match will return records with only the text string in the field(s) being searched.

c. Begins with will return records in which the field(s) being searched begin with the text string.

d. Ends with will return records in which the field(s) being searched end with the text string.

e. Wildcard will allow searches containing a wildcard character--either a percent sign (%) to replace multiple characters, or one or more underscores (_) to replace an exact number of characters (one underscore for each character).  If you use a wildcard character, you MUST select the wildcard comparison value.  Otherwise, the wildcard will be read as literal text. If you choose “Wildcard” but do not enter a wildcard character, the search will treat the text string as an “Exact match.”

· Dropdown menus:  With the exception of the Comparison options, it is not necessary to select a value from other fields with dropdown options.  You may use them as additional search parameters if desired. However, once you select a value from a dropdown menu, you cannot null it out without clearing all the search criteria (“New Search” on File menu). You can only change it to another value.

· ID fields: Entries in ID fields must be the entire numeric record ID. Whenever an ID is entered in a Find window, it will override all other search criteria that have been entered. Only the record matching the ID will be returned in the results section.

2.3.3 Default Settings 

The default search settings for specific Find windows are listed in the On-line Help for each Find window. Those defaults apply to the Find window opened from the main window or detail window for use in searching for records to be viewed or edited (use #1 above).  The user can control whether the Find window opens with the system defaults or with the criteria from the last search he or she performed, but cannot change the default settings.

When a Find window is opened to add data by inserting a link between one record and another (use #2 above), the default settings depend on the data field being filled in. For example, the Find Element window may be limited to searching for only taxa or only communities, depending on the context.  Find windows that open with context-specific default settings do not allow the user to override the settings. This protects data integrity by preventing inappropriate record linkages.

When a Find window opens during record copy, its default settings will depend on the target record (that is, the record from which the copy operation is being launched).  For example, the system will not allow a community characterization record to be copied into a plant characterization record; therefore, the Find window automatically limits the search to botanical records. Again, the user cannot override these settings.

2.3.4 Common Features of Find Windows

The following functions are available in the Find windows of all subject areas, except for Find Classification and Find USFS Ecoregion.

· Save searches:  A set of search criteria can be named, saved, and reused. Saved searches can be deleted or renamed. The searches a user saves are specific to that user’s profile. They are not available to other users in the same installation (unlike queries created in Query Builder, which can be shared).

· Save settings: The user can choose whether the Find window will open with system default settings or with the criteria it contained when it was last closed .

· View detail window:  The “Details…” button opens the detail window for the record selected in the Results section of the Find window.  If more than one row  is selected, only the detail for the first row opens.

· Create new record:  If a search does not locate a record, it may be necessary to add it to the database. The “New” button permits users to begin creating a new record directly from the Find window.

· Select multiple results:  The “Select All” and “Select None” buttons allow users to select and deselect all the results returned by a search. Multiple consecutive rows can be selected by highlighting them while holding down the Shift key; multiple nonconsecutive rows can be selected by highlighting them while holding down the Ctrl key.

· Add results to a Working List:  When the Find window is opened from the main window, the selected results can be added to an existing Working List or a blank main window by using the “Add to List” button. The “Replace List” button will replace the records displayed in a Working List with records highlighted in the results section of the Find window. (Note that these changes are not permanent until the Working List has been saved—see the task Update a Working List.) 

· View the SQL executed by the search:  It is viewable by selecting Options – View Search SQL.

· Cut, copy, and paste:  These functions are on the Edit menu of the Find window.

2.3.5 Managing Searches and Settings

Users may want to save searches done through the Find windows, especially those with multiple tabs, if the searches are going to be reused periodically—for example, to refresh the contents of a Working List of records based on criteria that may change over time.

To save a new search:

· Enter search criteria in the Find window and select “Find Now”  to make sure the search is returning the records you want.

· From the Find window menu, select File – Save Search As or File – Save Search. The “Save User Search” dialog opens. It can also be opened with the [image: image8.bmp] button, or with the keystrokes Alt-F-S or Alt-F-A.  DO NOT USE Ctrl-S to save a NEW search.  It will overwrite your most recently saved search.

· Enter a name for the search and select the “Save” button. The name you enter must only be unique to your own saved searches.  The names of saved searches are specific to each user.

To resave a previously saved search:

· Open the saved search and make any needed changes to the criteria.

· Select File – Save Search, or Ctrl-S, or Alt-F-S, or [image: image9.bmp] in the Find window.

To open a saved search:

· From the Find window menu, select File – Open Search. The “Open User Search” dialog opens. It can also be opened with the [image: image10.bmp] button, or with the keystrokes Ctrl-O or Alt-F-O.

· Highlight the name of the search to be opened and select the “Open” button.

To rename a saved search:

· Open the search and make any needed changes to the criteria.

· Select File – Save Search As or use keystrokes Alt-F-A. The “Save User Search” dialog opens.

· Enter a name for the search and select the “Save” button. The original search will still be saved under its old name.

To delete a saved search:

· Select File – Delete Search or use keystrokes Alt-F-D. The “Delete User Search” dialog opens.

· Highlight the name of the search to be deleted and select the “Delete” button.

To retrieve the latest search criteria the next time a Find window is opened:

· Select Options on the Find window menu bar or use keystrokes Alt-O.

·  Put a checkmark next to “Save Settings as Default” by highlighting that line and clicking with the mouse, pressing Enter, or using keystrokes Alt-O-D.

Exercise caution when setting this option in multi-tab Find windows.  Criteria hidden on the tabs may affect results. This option is available independently for every subject area’s Find window.  It  may be set for some and not others.

To open a blank Find window (contains system default settings only):

· Uncheck the option “Save Settings as Default.”  

To clear out search settings: 

· At any time while using the Find window, select File – New Search, or Ctrl –N, or Alt-F-N, or use the [image: image11.bmp] button. 

2.4 Other Basic Tasks

2.4.1 Delete Records

Most types of records in Biotics Tracker can be deleted by using Edit – Delete (Alt-E-D) or the [image: image12.bmp] on the toolbar in the detail window. The exceptions are as follows:

· EO tabular records cannot be deleted in Tracker if they were created in Mapper. The EO spatial representation in Mapper must be deleted first, which will automatically delete the Tracker record.  The delete menu option and icon in Tracker are disabled.

· Source Feature tabular records cannot be deleted in Tracker if they were created in Mapper. The spatial representation of the Source Feature must be deleted in Mapper first, which will automatically delete the Tracker record. (EOs linked to the Source Feature, if any, must have already been deleted.)  The delete menu option and icon in Tracker are disabled.

· Managed Area and Site tabular records that are linked to spatial representations in Mapper cannot be deleted in Tracker. The delete menu option and the icon are not disabled, but if the user tries to delete the Tracker record first, a message instructs him or her to delete the associated shape in Mapper. Doing so will not delete the MA or Site tabular record. It must be deleted manually.

When “Delete” is selected, a message asking for confirmation of the delete will appear.  The default choice is No, to prevent accidentally deleting a record. For example:
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A user must have the Delete function for a specific record type in his or her security configuration in order to be able to delete it.

Deleting Element Tracking Records

In general, the only reason an Element Tracking record would be deleted is to correct a data entry error—for example, if  an Element that does not exist in the jurisdiction was added to the database by mistake. However, when taxonomic/classification changes occur and the circumscription of an Element changes, the record should not be deleted. Instead, it should be inactivated, which keeps the data in the database for easy reference (see section 2.11 on Lineage Tracking).

2.4.2 Copying between Individual Fields 

Text fields

In rich-text or non-rich-text text boxes, highlight the contents you wish to copy, and select Edit-Copy or use the Copy tool button or Ctrl-C. Then paste the text into another text field in the same or a different record.

· In rich-text fields, you may copy and paste directly from or into the text box on the detail window, or in the Text Editor, which has its own Cut-Copy-Paste menu.

· In non-rich-text fields, right clicking when the cursor is in that field displays an edit menu that also allows you to copy and paste.
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Text fields in grids

· Before trying to copy the contents of a grid field, double-click on the grid cell to go into edit mode. You can then copy all or some of the contents.

· On Master-Detail tabs, you cannot copy directly into or from the Master grid. Use the detail fields instead. 

· To copy into or from grids on extensible tabs, use the dropdown menu shown above by right-clicking on the field.  The Cut-Copy-Paste functions on the window menu and button bars do not work, nor does Ctrl-C.
 

Other data types or control types

· To copy from or into a numeric data type field or date field, right-click on the field to reveal the edit dropdown.

· It is not possible to copy from or into combo box controls (fields that display domain values) or multi-list boxes linked to a domain table (e.g., keyword lists).

2.4.3 Copying Text from Other Applications

It is possible to copy and paste formatted text from other applications (such as MS Word) into the rich-text fields in Biotics Tracker.  When the initial paste is done, the text will appear as it did in the original document—same type font, size, etc. For example:
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However, after the record has been saved and closed, the next time it is opened any formatting that is not supported in the Biotics Tracker Text Editor—such as indents and bullets—is removed, while supported formatting (boldface, italics, underline) remains.
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2.5 Working Lists

A Working List is a set of Biotics Tracker records that can be saved and retrieved.  Working Lists can be created in any Subject Area, but not for higher Classification records or USFS Ecoregions. They appear in a grid on the main window of the application. The grid columns are unique for each subject area and are designed to give the information most useful for distinguishing between records at a glance.

A Working List is created by performing one or more searches using a Find window or the Query Builder tool. It represents a static snapshot of the records that met the search criteria when the working list was created or last updated and saved.  It is not dynamically refreshed as new records meet those criteria.

Example: On January 2, a Working List is created containing the Element Subnational Tracking (EST) records of vertebrate animals in Virginia with a global rank of G1, G2, or G3.  On January 7, the global rank of a vertebrate that is tracked in Virginia is changed from G4 to G3. When the working list is retrieved on January 10, it does not contain the EST for that animal. A search using the same criteria would have to be run again to add that record to the list.

It is not necessary to save a Working List every time that records are retrieved into the main window of Biotics Tracker. However, saving the list is an easy way to make those same records available during a later work session without having to search for them again.

Only one Working List at a time may be open in a given subject area. However, Working Lists may be open in multiple subject areas at the same time. The different lists are accessed by changing the view (under the View menu item).

2.5.1 Opening Records from a Working List

To open a record in any working list, double-click on the row showing that record.

Element Subject Area

Double-clicking on a Element working list opens the Element Tracking record at the geographic level indicated in the column Geolevel. Besides double-clicking, the menu choice File – Open – Element Tracking can be used. The cascading list from Element Tracking lets you open the EGT, ENT, or EST. Thus, you can open the exact Element Tracking record on the working list by selecting its level or the related Element Tracking record(s) at other geographic levels.
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The “Working List” choice on the cascading menu is unique to the Element working list. Selecting File – Open – Working List allows the user to move between records on the list without closing and reopening each record’s detail window, by opening the record as x of N, where x is the number of the row in which the record displays in the list and N is the total number of records in the list. This means that all the other records on the list are available from the detail window by using the working list navigation functionality (see illustrations below). Unless the working list choice is selected, each record on an Element working list opens as 1 of 1.

“Working List” is also an option for opening the Element Ranking and Element Characterization records related to the Element Tracking records on a working list.

Other Subject Areas

In all subject areas except Element, when you open a record on the record list by double-clicking or using File – Open, it opens as x of N, where x is the number of the row in which the record displays in the list and N is the total number of records in the list.  This means that all the other records on the working list are available from the detail window by using the arrows in the lower left corner of the window:
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or the equivalent items on the menu:
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2.5.2 Working List Menu Items

These items are on the Main Window menu under “List. They are also available from a tool button:
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These items perform the following functions:

· List -> New List - Removes current working list from the window and creates an empty, unsaved list.  Prompts you to save the list if you have added or deleted records, or changed the sort order.  If you do not have update privileges for the current working list, prompts you to save as under a new name and ownership. 

· List -> Open List - Opens a dialogue allowing the user to select the working list to open.  If you have another working list in the window, it is replaced by the list you select to open.  If the original list contained unsaved changes, you are NOT prompted to save or save as.  Your changes will be lost.

· List -> Save List - Saves the current list.  If the current list has not been saved before, or if you do not have update privileges to the current working list, the Save As dialogue is opened allowing you to give the list a name and set list properties.

· List -> Save List As - Allows you to save the current list under a new name and, if it is not your list,  different ownership.  Window opens with the Group field defaulted to All Groups and the Only show my lists checkbox checked.

· List -> Delete List - Opens a dialogue allowing you to select the working list to delete.  The Only show my lists checkbox is checked when the dialogue opens, but it can be unchecked to show other owners lists.  In addition to your own working lists, you can delete any list which is Shared-Updates Allowed.

· List -> List Properties - Opens a dialogue that allows you to change the name, description, folder, or shared/update status of the current working list. You may change the properties of your own lists or any list that is Shared-Updates Allowed.  If no updates are allowed, a message displays when the user selects this menu item.

· List -> Remove All Items - Removes all items from the working list window, allowing you to repopulate the list.  The list name and properties are maintained.

· List -> Remove Selected Items - Removes the selected items from the working list.  Because the working list allows for multi-select using standard windows keystrokes (shift, control), multiple items can be removed at once.

· List -> Generate Working List - Enables you to merge two working lists in the same subject area or to create another working list in the same or a different subject area that consists of records related to the records in the current working list. If the current working list has been modified, you will be prompted to save changes before the new working list is generated.

· List -> Sort List - Opens a dialogue that allows you to select multiple columns on which to sort, as well as whether to sort by ascending or descending order (alphabetical or numerical, depending on the contents of the columns selected).  

· View -> Refresh - (Under the “View” menu option on Main Window) Refreshes working list from the database.  Prompts you to save changes to the composition of the working list before refreshing if you have added or deleted records from the working list, or changed the sort order. If you do not have update privileges for the current working list, prompts you to save as under a new name and ownership.

2.5.3 Working List Properties

Properties are set when a working list is saved.  They can be modified later by the list owner or users allowed to share the list.
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A saved Working List has the following attributes:

· Owner – the login name of the user who first saved the list. Automatically filled in by the system.

· Name – a text string up to 50 characters long.  This is a required field that must be entered by the owner the first time the list is saved.  It can be modified later if desired.

· Description – a text string up to 500 characters long. It may be used to describe the contents of the list or the search(es) that produced it.  Optional and modifiable.

· Share/update status – a required field whose value indicates whether users in addition to the owner will be able to see the list and, if so, whether they can make changes to it and its properties. This status can be modified if desired. The value options are:

· Not Shared (default value) – the Working List is only visible to the owner.

· Shared—No Updates Allowed – other users can view the Working List but cannot add or delete records from it or change its properties.

· Shared—Updates Allowed – other users can change the contents and properties of the Working List. 

· Date/time modified – automatically filled in or updated by the system when a list is saved.

· Last modified by – the user’s login name automatically filled in or updated by the system when a list is saved.

· Number of records – automatically filled in or updated by the system when a list is saved. 

· Folder – a required field with value options that are customizable by each Biotics Tracker installation. It enables lists to be sorted into different categories (“folders”) to make them easier to retrieve.

These attributes, along with a working_list_id and working_list_type (the subject area), are stored in an Oracle table in the database and can be used in SQL queries.
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2.5.4 Working List User Options

Several of the personal options available under the Tools – Options… menu pertain to Working Lists:

· On the Startup Options tab, the user can specify whether or not the last working list  he or she viewed before exiting the application should be open in the main window the next time the user starts Biotics Tracker.

· On the Working List tab, the user can specify whether or not the application should prompt for saving an unsaved or changed Working List either when the view changes or when the user exits.

· Save when View changes – When you change to another view (i.e., from Element to Element Group on the View menu), the current working list is saved without prompt if it has been modified.  If the list has never been saved before or if you are not allowed to update the current working list, the save as prompt will appear.

· Ask to save when View changes –  When you change to another view, you are asked if you want to save the current working list if it has been modified.  If you answer yes a previously saved list will be resaved.  If the list has never been saved before or if you are not allowed to update the current working list, the save as prompt will appear.

· Do not save when View changes –  When you change to another view, no prompt is given and no changes to the working list are saved.

· Save on Exit –  When you quit the application, all working lists that have been modified are saved without prompt.  A previously saved list will be resaved.  If the list has never been saved before or if you are not allowed to update the current working list, the save as prompt will appear.

· Ask before Saving on Exit –  When you quit the application you are asked if you want to save all modified working lists.  If you answer yes a previously saved list will be resaved.  If the list has never been saved before or if you are not allowed to update the current working list, the save as prompt will appear.

· Do not Save on Exit – When you quit the application, no prompt is given and no changes to the working list are saved.
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2.6 Navigation between Records in Biotics Tracker

Related records are only a couple of mouse-clicks away in Biotics Tracker. An attempt was made to replicate The ability to move between records that was available in BCD has been retained in most cases,
 and even greater flexibility has been added.  

There are four basic ways to move between records in Biotics Tracker:

1. File-Open options from a Working List.  Same options are displayed from menu or button bar, or by right-clicking on an item in the list.

2. File-Open options from inside a detail window (original record remains open).

3. Double-clicking on a record listed in a grid in a detail window(original record remains open).

4. Using the Find window from inside a detail window to open another record (original record is replaced with newly opened record).

Navigation is closely tied to New Record creation, because the only way to create many types of Element records is to “navigate” to them using methods 1 or 2, above.  If they do not yet exist, a New Record window will open. The exception is Element Tracking records. They can only be created by selecting the File-New menu option or button from the Working List window or from inside an Element Tracking detail window.

2.6.1 General Principles and Specific Rules

· You can navigate between existing Element records of any geographic level.

· For Element Tracking records, you can only create a national-level record from an EGT or another ENT; you can only create a subnational-level record from an ENT or another EST.

· For other types of Element records (e.g., ranking, characterization), you can only create a new record at the same geographic level as the record you have open or that you have highlighted on the Working List. For example:

· From an EGT, you can open the existing ESRs for that Element, but if none exist you will get the following message: 
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· You can only create a new ENR or CAN from an ENT.

· You can only create a new ESR or CAS from an EST.

· You can only create a global-level Element record (EGR, CAG, CCAL, Element Management, EO Specs, or EO Rank Specs) from another global-level Element record. (For navigation purposes, CCAL is a “global-level” record because it is directly related to the EGT.)

· You can only create a new Element/Site record from an EGT or Site record.

· You can navigate between existing records in different subject areas, but you cannot create a New Record outside the subject area of your current View. For example: 

· You can open related EOs from an EST on an Element Working List (Element View).  If no related EOs exist, you get the following message: 
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· You cannot create an Element Group record from anywhere except the Element Group subject area, but you can open existing Element Group records from the EGTs of their member elements (those that are listed in the Element Group record) or from the related Element Management, EO Specs, or EO Rank Specs record.

2.6.2 Navigation Roadmap

Table 1 provides a roadmap from each type of record to other records.  Here are some notes and definitions to help you understand the table.

1. For Element Tracking records (EGTs, ENTs, and ESTs) and for records in other Subject Areas, the navigation choices are the same from the pop-up menu retrieved by right-clicking in the Working List, from File-Open on the Working List, and from File-Open in the detail window, except that the latter includes Record Maintenance and Attribute Maintenance. For other types of “Element” records (e.g., EGR, CAS, etc.), the navigation options listed are only available from inside the detail window by choosing File-Open (menu or button).

2. Number of Records Retrieved: If this column says 0-n and multiple related records exist, they will open as 1 of n.  You can navigate among them using the Next - Previous function or the “mini” Working List that can be opened from the menu or tool bar (see Figure 1 on next page).

3. Opens new window?: This column indicates whether a New Record window will open (Y) or not (N) if no related records exist when you select a given navigation option; “n/a” means that type of record must already exist.

Figure 1.  Related EST records opened from an EGT: 
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Table 1.  Navigation Roadmap: 

	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	EGT 
	Element Tracking
	Global (EGT)
	1
	n/a
	Selection from Working List (right-click or File-Open) opens the highlighted EGT, selection from File-Open menu inside the open detail window does nothing

	
	
	National (ENT)
	0-n
	N
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	1
	Y
	

	
	
	National (ENR)
	0-n
	N
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	1
	Y
	

	
	
	National (CAN)
	0-n
	N
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	1-n
	Y
	Communities only

	
	Scientific Names
	Global
	1
	N
	

	
	
	Concept
	1
	N
	

	
	
	Synonyms
	0-n
	N
	From SYNONYMS_GLOBAL table (n/a for communities)

	
	Element Management
	
	0-1
	Y
	

	
	EO Specs
	
	0-1
	Y
	

	
	EO Rank Specs
	
	0-1
	Y
	

	
	Element References
	
	1
	n/a
	From ELEMENT_GLOBAL_REF table

	
	Element/Site 
	
	0-n
	Y
	

	 
	Element Ecoregion
	 
	0-1
	Y
	Communities only; opens global-level record only

	
	Element Groups
	
	0-n
	N
	

	
	Element Occurrences
	
	0-n
	N
	

	
	Source Features
	
	0-n
	N
	

	
	Managed Areas
	
	0-n
	N
	Only those linked to EGT open, not to related ENTs or ESTs


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	ENT
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	Selection from Working List opens the highlighted ENT, selection from File-Open menu in detail window does nothing

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	0-1
	N
	

	
	
	National (ENR)
	1
	Y
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	0-1
	N
	

	
	
	National (CAN)
	1
	Y
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	0-n
	N
	Communities only

	
	Scientific Names
	Global
	1
	N
	

	
	
	Concept
	1
	N
	

	
	
	National
	1
	N
	This choice appears on File-Open menu of ENT

	
	
	Synonyms
	0-n
	N
	From SYNONYMS_NATIONAL table (n/a for communities)

	
	Element Management
	
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element References
	
	1
	n/a
	From ELEMENT_NATL_REF table

	
	Element/Site 
	
	0-n
	N
	

	 
	Element Ecoregion
	 
	1
	Y
	Communities only; opens nat'l-level record only

	
	Element Groups
	
	0
	N
	

	
	Element Occurrences
	
	0-n
	N
	

	
	Source Features
	
	0-n
	N
	

	
	Managed Areas
	
	0-n
	N
	Only those linked to ENT open


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	EST
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	

	
	
	Subnational (EST)
	1
	n/a
	Selection from Working List opens the highlighted EST, selection from File-Open does nothing

	
	Element Ranking
	Global (EGR)
	0-1
	N
	

	
	
	National (ENR)
	0-1
	N
	

	
	
	Subnational (ESR)
	1
	Y
	

	
	Element Characterization
	Global (CAG)
	0-1
	N
	

	
	
	National (CAN)
	0-1
	N
	

	
	
	Subnational (CAS)
	1
	Y
	

	
	
	Local (CCAL)
	0-n
	N
	Communities only

	
	Scientific Names
	Global
	1
	N
	

	
	
	Concept
	1
	N
	

	
	
	Subnational
	1
	N
	This choice appears on File-Open menu of EST

	
	
	Synonyms
	0-n
	N
	From SYNONYMS_SUBNATIONAL table (n/a for communities)

	
	Element Management
	
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element References
	
	1
	n/a
	From ELEMENT_SUBNATL_REF table

	
	Element/Site 
	
	0-n
	N
	

	 
	Element Ecoregion
	 
	1
	Y
	Communities only; opens subnat'l-level record only

	
	Element Groups
	
	0
	N
	

	
	Element Occurrences
	
	0-n
	N
	

	
	Source Features
	
	0-n
	N
	

	
	Managed Areas
	
	0-n
	N
	Only those linked to EST open


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	EGR
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	0-n
	N
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	1
	n/a
	Selection does nothing

	
	
	National (ENR)
	0-n
	N
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	1
	Y
	

	
	
	National (CAN)
	0-n
	N
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	1-n
	Y
	Communities only

	
	Element Management
	
	1
	Y
	

	
	EO Specs
	
	1
	Y
	

	
	EO Rank Specs
	
	1
	Y
	

	
	Element References
	
	1
	n/a
	From ELEMENT_GLOBAL_REF table

	
	Element Ecoregion
	
	1
	Y
	Communities only; opens global-level record only

	 
	 
	 
	 
	 
	 

	ENR
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	0-1
	n/a
	

	
	
	National (ENR)
	1
	n/a
	Selection does nothing

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	0-1
	N
	

	
	
	National (CAN)
	1
	Y
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	0-n
	N
	Communities only

	
	Element Management
	
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element References
	
	1
	n/a
	From ELEMENT_NATL_REF table

	
	Element Ecoregion
	
	1
	Y
	Communities only; opens nat'l-level record only


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	ESR
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	

	
	
	Subnational (EST)
	1
	n/a
	

	
	Element Ranking
	Global (EGR)
	0-1
	N
	

	
	
	National (ENR)
	0-1
	N
	

	
	
	Subnational (ESR)
	1
	n/a
	Selection does nothing

	
	Element Characterization
	Global (CAG)
	0-1
	N
	

	
	
	National (CAN)
	0-1
	N
	

	
	
	Subnational (CAS)
	1
	Y
	

	
	
	Local (CCAL)
	0-n
	N
	Communities only

	
	Element Management
	
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element References
	
	1
	n/a
	From ELEMENT_SUBNATL_REF

	
	Element Ecoregion
	
	1
	Y
	Communities only; opens subnat'l-level record only

	
	
	
	
	
	

	CAG
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	0-n
	N
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	1
	Y
	

	
	
	National (ENR)
	0-n
	N
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	1
	n/a
	Selection does nothing

	
	
	National (CAN)
	0-n
	N
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	1-n
	Y
	Communities only

	
	Element Management
	
	1
	Y
	

	
	EO Specs
	
	1
	Y
	

	
	EO Rank Specs
	
	1
	Y
	

	
	Element References
	
	1
	n/a
	From ELEMENT_GLOBAL_REF table

	
	Element Ecoregion
	
	1
	Y
	Communities only; open global-level record only


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	CAN
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	0-1
	N
	

	
	
	National (ENR)
	1
	Y
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	0-1
	N
	

	
	
	National (CAN)
	1
	n/a
	Selection does nothing

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	0-n
	N
	Communities only

	
	Element Management
	
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element References
	
	1
	n/a
	From ELEMENT_NATL_REF table

	
	Element Ecoregion
	
	1
	Y
	Communities only; opens nat'l-level record only

	
	
	
	
	
	

	CAS
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	

	
	
	Subnational (EST)
	1
	n/a
	

	
	Element Ranking
	Global (EGR)
	0-1
	N
	

	
	
	National (ENR)
	0-1
	N
	

	
	
	Subnational (ESR)
	1
	Y
	

	
	Element Characterization
	Global (CAG)
	0-1
	N
	

	
	
	National (CAN)
	0-1
	N
	

	
	
	Subnational (CAS)
	1
	n/a
	Selection does nothing

	
	
	Local (CCAL)
	0-n
	N
	Communities only

	
	Element Management
	
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element References
	
	1
	n/a
	From ELEMENT_SUBNATL_REF table

	
	Element Ecoregion
	
	1
	Y
	Communities only; opens subnat'l level record only


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	CCAL 
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	0-n
	N
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	1
	Y
	

	
	
	National (ENR)
	0-n
	N
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	1
	Y
	

	
	
	National (CAN)
	0-n
	N
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	1
	n/a
	Selection does nothing

	
	Element Management
	
	1
	Y
	

	
	EO Specs
	
	1
	Y
	

	
	EO Rank Specs
	
	1
	Y
	

	
	Element References
	
	1
	n/a
	From ELEMENT_GLOBAL_REF table

	 
	Element Ecoregion
	 
	1
	Y
	Opens global-level record only

	
	Geographic Area
	
	1
	n/a
	The site, MA, county, USFS ecoregion (any level), or TNC ecoregion for which the CCAL was created

	
	
	
	
	
	

	Element Mgmt
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	0-n
	N
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	1
	Y
	

	
	
	National (ENR)
	0-n
	N
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	1
	Y
	

	
	
	National (CAN)
	0-n
	N
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	1-n
	Y
	Communities only

	
	Element Management
	
	1
	n/a
	Selection does nothing

	
	EO Specs
	
	1
	Y
	

	
	EO Rank Specs
	
	1
	Y
	

	
	Element References
	
	1
	n/a
	From ELEMENT_GLOBAL_REF table

	 
	Element Ecoregion
	 
	1
	Y
	Communities only; opens global-level record only

	
	Element Group
	
	0-1
	N
	


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	EO Specs
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	0-n
	N
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	1
	Y
	

	
	
	National (ENR)
	0-n
	N
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	1
	Y
	

	
	
	National (CAN)
	0-n
	N
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	1-n
	Y
	Communities only

	
	Element Management
	
	1
	Y
	

	
	EO Specs
	
	1
	n/a
	Selection does nothing

	
	EO Rank Specs
	
	1
	Y
	

	
	Element References
	
	1
	n/a
	From ELEMENT_GLOBAL_REF table

	 
	Element Ecoregion
	 
	1
	Y
	Communities only; opens global-level record only

	
	Element Group
	
	0-1
	N
	

	
	
	
	
	
	

	EO Rank Specs
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	0-n
	N
	

	
	
	Subnational (EST)
	0-n
	N
	

	
	Element Ranking
	Global (EGR)
	1
	Y
	

	
	
	National (ENR)
	0-n
	N
	

	
	
	Subnational (ESR)
	0-n
	N
	

	
	Element Characterization
	Global (CAG)
	1
	Y
	

	
	
	National (CAN)
	0-n
	N
	

	
	
	Subnational (CAS)
	0-n
	N
	

	
	
	Local (CCAL)
	1-n
	Y
	Communities only

	
	Element Management
	
	1
	Y
	

	
	EO Specs
	
	1
	Y
	

	
	EO Rank Specs
	
	1
	n/a
	Selection does nothing

	
	Element References
	
	1
	n/a
	From ELEMENT_GLOBAL_REF table

	 
	Element Ecoregion
	 
	1
	Y
	From EL_GLOBAL_USFS ECOREG and EL_GBL_TNC_ECOREG (communities only)

	
	Element Group
	
	0-1
	N
	


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	Element References
	References
	
	1-n
	n/a
	Double-clicking on a row open the individual reference record as 1of 1

	 
	 
	 
	 
	 
	 

	Element Global Ecoregion
	Element Tracking
	Global
	1
	n/a
	

	
	
	National
	0-n
	N 
	Defect #2812 in current software release

	
	
	Subnational
	0-n
	N
	Defect #2812 in current software release

	 
	 
	 
	 
	 
	 

	Element National Ecoregion
	Element Tracking
	Global
	1
	n/a
	

	
	
	National
	0-n
	N
	Defect #2812 in current software release

	
	
	Subnational
	0-n
	N 
	Defect #2812 in current software release

	 
	 
	 
	 
	 
	 

	Element Subnatl Ecoregion
	Element Tracking
	Global
	1 
	n/a
	

	
	
	National
	0-n
	N 
	

	
	
	Subnational 
	0-n
	N
	

	 
	 
	 
	 
	 
	 

	Element/ Site
	Element Global Tracking
	
	1
	n/a
	

	
	Site
	
	1
	n/a
	

	
	Managed Area
	
	0-1
	N
	

	
	References
	
	0-n
	N
	

	 
	 
	 
	 
	 
	 

	Element Group
	Element Group details
	 
	1
	n/a
	Open highlighted record on Element Group Working List

	
	Element Global Tracking
	
	0-n
	n/a
	Double-clicking on a row in the Member Elements grid opens an individual EGT as 1 of 1

	 
	EO Specs
	 
	1
	Y
	It is possible to create, e.g., an EO Specs record for an Element Mgmt group. Next version of application should prevent this (TestTrack #1846)

	 
	EO Rank Specs
	 
	1
	Y
	

	 
	Element Management
	 
	1
	Y
	

	
	References
	
	0-n
	N
	


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	EO
	Element Occurrence details
	
	1
	n/a
	

	
	Principal EO
	
	1
	n/a
	

	
	Sub-EOs
	
	0-n
	N
	

	 
	EO Ecoregion
	 
	0-1
	Y
	Communities only

	
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	

	
	
	Subnational (EST)
	1
	n/a
	

	
	Element Ranking
	Global (EGR)
	0-1
	N
	Not functioning correctly in current release of 

	
	
	National (ENR)
	0-1
	N
	Tracker. “New Record” window opens for 

	
	
	Subnational (ESR)
	0-1
	N
	these record types from inside the EO detail 

	
	Element Characterization
	Global (CAG)
	0-1
	N
	window (TestTrack #2909). Behavior from 

	
	
	National (CAN)
	0-1
	N
	working list is correct.

	
	
	Subnational (CAS)
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element Subnational References
	
	1
	n/a
	

	
	Source Features
	
	1-n
	n/a
	

	
	Managed Areas
	
	0-n
	N
	

	
	Sites
	
	0-n
	N
	

	
	References
	
	0-n
	N
	

	
	Contacts
	
	0-n
	N
	


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	Source Feature
	Source Feature details
	 
	1
	n/a
	 

	
	Element Occurrences
	
	0-1
	N
	

	
	EO Ecoregion
	
	0-1
	N
	Communities only

	
	Element Tracking
	Global (EGT)
	1
	n/a
	

	
	
	National (ENT)
	1
	n/a
	

	
	
	Subnational (EST)
	1
	n/a
	

	
	Element Ranking
	Global (EGR)
	0-1
	N
	

	
	
	National (ENR)
	0-1
	N
	

	
	
	Subnational (ESR)
	0-1
	N
	

	
	Element Characterization
	Global (CAG)
	0-1
	N
	

	
	
	National (CAN)
	0-1
	N
	

	
	
	Subnational (CAS)
	0-1
	N
	

	
	EO Specs
	
	0-1
	N
	

	
	EO Rank Specs
	
	0-1
	N
	

	
	Element Subnational References
	
	1
	n/a
	


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	EO Ecoregion
	Element Occurrence
	
	1
	n/a
	

	 
	 
	 
	 
	 
	 

	Alliance Ecoregion
	Alliance
	
	1
	n/a
	

	 
	 
	 
	 
	 
	 

	Ecoregion
	Element Tracking
	Global
	0-n
	N
	

	
	
	National
	0-n
	N
	

	
	
	Subnational
	0-n
	N
	

	 
	 
	 
	 
	 
	 

	Managed Areas
	Managed Area details
	
	1
	n/a
	

	
	Major MA
	
	0-1
	N
	

	 
	Equi-Site
	 
	0-1
	N
	 

	
	Element Tracking
	
	0-n
	N
	

	
	Element Occurrences
	
	0-n
	N
	

	
	Sites
	
	0-n
	N
	

	
	References
	
	0-n
	N
	

	 
	 
	 
	 
	 
	 

	Sites
	Site details
	
	1
	n/a
	

	
	Macrosite
	
	0-1
	N
	

	 
	Megasite
	 
	0-n
	N
	 

	
	Defining Managed Area
	
	0-1
	N
	

	
	Element/Site
	
	0-n
	Y?
	

	
	Element Occurrences
	
	0-n
	N
	

	
	References
	
	0-n
	N
	


	Record/ Window
	Main Menu Item
	Cascading Items
	No. of records retrieved
	Opens "New Record" window?
	Notes

	Classification 
	Alliance Ecoregion
	
	0-1
	Y
	Only applicable when you have an Alliance selected in the tree view.

	
	Element Global Tracking
	 
	 
	 
	Accessed via the "Generate Working List" function in this version of the software (TestTrack #2701)

	 
	 
	 
	 
	 
	 

	Scientific Name
	Scientific Name details
	
	1
	n/a
	

	 
	Nomenclaturally Established Name
	 
	0-1
	N
	 

	
	References
	
	0-n
	N
	From SCIENTIFIC_NAME_REF

	 
	 
	 
	 
	 
	 

	Contacts
	Contact details
	 
	 
	 
	 

	
	Element Occurrences
	
	0-n
	N
	

	
	References
	
	0-n
	N
	

	 
	 
	 
	 
	 
	 

	References
	Reference details
	 
	1
	n/a
	 

	
	Contacts
	
	0-n
	N
	


2.7 Keystroke Navigation within Records

Keystroke navigation is possible for most tasks.

In a Working List window:

· The up-down arrows move you between records

· The left-right arrows allow you to scroll across all columns

· “Enter” opens the highlighted record

· “Alt + [letter]” takes you to menu items (hold down Alt to set shortcut keys on menu bar)

In a detail window:

· Tab key moves you to the next field or control (e.g., a button), and Shift-Tab moves you to the previous field or control

· In a dropdown field, the up-down arrows move through the value options. You may also move to a value option by starting to type it.

· The up-down or left-right arrow keys move between tabs

· Alt + the underlined letter in a tab name moves you to a specific tab. (Note: a few tabs in the application do not have shortcut letters because no unique letter was available in the tab name.)

· “Enter” adds or removes the check in a checkbox

In a grid:

· The left-right arrow keys move you between cells

· The up-down arrow keys move you between rows

· In grids or multi-valued fields that are NOT populated by opening a Find window, hitting Enter add a new line.

· In dropdown fields in grids, hitting Enter displays the value options

Record Copy Functionality

Three types of copying are available through the Biotics 4 Tracker GUI:

1. Copying an EGT and all its related Element records (“deep copy”)

2. Copying an individual record (“shallow copy”)

3. Copying text from one field to another.

Shallow copy is similar to the Alt-C functionality in BCD.  Full replication of Alt-C functionality is listed as a future enhancement (TestTrack #83).  Likewise, replication of Alt-O functionality for copying fields is not included in this version of the software (TestTrack #82), but copy-cut-paste is available for almost all fields.  All types of copying are carried out in detail windows.  There is no copying of or from a working list.

2.7.1 Deep Copy

Records and fields copied

This function copies an EGT and all of the following related record types, if they exist:

· ENT, EST

· EGR, ENR, ESR

· CAG, CAN, CAS, CCAL

· EO Specs, EO Rank Specs

· Element Management

· Element References (special rules apply—see below)

· Element Ecoregion (Global, National, and Subnational records)

· Element Site

Related EO and Source Feature records are NOT copied.

Only non-key data fields are copied, meaning that the fields that uniquely identify the EGT as the primary or alternate keys are not copied.  Some other fields from related tables are also not copied.  See Table 1 in Appendix A for a complete list of the EGT fields that are not copied.  All fields from related records are copied, except the foreign key to the parent Element Tracking record.

Procedure

Deep copy is initiated from inside the EGT detail window of the record that you wish to copy into, most likely a newly created EGT that does not have any associated records. If you copy into an EGT that does have associated records (for example, an ENT or an EGR for that element), those records will be deleted or completely overwritten during the deep copy.  Therefore it is advisable to always create a new EGT prior to using deep copy.

The typical workflow is as follows:

1. Create a new EGT record containing the minimum necessary data.
  Save the new record. You will be prompted to save when you try to initiate “deep copy” if you haven’t already saved it. This is your target EGT.

2. Select “Tools – Copy Data From” on the Menu bar.  The dialog box shown below appears.  Select “Deep.”
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3. The Find Element window opens, with the Results Filter pre-set to Global (i.e., it will only retrieve EGT records).  In addition, the Name Type radio button is pre-set to the same type as the target record. Search for the Element that you want to copy and click OK. The record you selected is your source EGT.

4. You will receive the following warning:
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Select Yes to proceed (note that No is the default).

5. After a pause (be patient!), the non-key contents of the source record appear in the target. The target EGT has been automatically saved, as have all the associated records that were created during the deep copy.

Checklist for copied records

Here are some data items that you may wish to double-check after performing a deep copy. Everyone should develop his or her own checklist for specific scenarios in which you use deep copy.

1. Is the element linked to the correct genus or alliance?

2. Do you need to change any NNAMEs and/or SNAMEs? (ENTs and ESTs will inherit the NNAME and SNAME from the source record, not the GNAME from the target.)

3. Do the copied common names apply to the new element?

4. Do all the copied Element References apply to the new element? (The Primary Name Reference from the source EGT is copied to the list, but does not replace the Primary Name Reference designated in the target EGT.)

2.7.2 Shallow Copy

This functionality copies only one record at a time. As with deep copy, you start from inside the detail window of the record that you wish to copy into.  Shallow copy is available for all record types except USFS Ecoregion.  

Shallow copy is essentially a subset of deep copy—that is, deep copy is made up of a lot of separate shallow copy operations.  See Tables 1 and 2 of Appendix A for information about what element tracking fields are and are not copied.  For other record types, the general rule is that any field required in order to save a record is not copied during shallow copy, but all others are copied.

Procedure

1. Create a new record containing the minimum necessary data (required fields only).
 Save the new record. You will be prompted to save when you try to initiate copy if you haven’t already saved the record. This is your target record.

2. Select “Tools – Copy Data From” on the Menu bar.

· In an EGT, you must then select “Shallow” from the dialog box shown on the previous page.

· In any other type of record, that dialog does not appear because shallow copy is the only record copy functionality available.

3. The appropriate Find window opens. Search for and select the record you want to copy (the source record), and click OK. When copying any type of element record, the Name Type and geographic level in the Find window are pre-selected to match those of the target record.

4. You will receive the data loss warning message. Click Yes to continue with the copy procedure.

5. The non-key contents of the source record appear in the target. The target record has been automatically saved.

Checklist for copied records

Here are some data items that you may wish to double-check after performing a shallow copy of an element record:

1. Are the NNAME or SNAME in the target record correct? (As in deep copy, they are overwritten with the name from the source record.)

2. Is the Primary Name Reference Citation correct? (The target record’s data is overwritten but the reference stays in the Element Reference list.)

3. Are all the references listed in the Element Reference list appropriate?

See Table 2 in Appendix A for rules related to copying ENT and EST, and Appendix B for a list of what references are copied with what records.

2.7.3 Field copy rules for EGT, ENT, and EST and their related references.

Table 1.  Data in EGT and Element References windows that are NOT copied during Deep Copy or Shallow Copy

	Attribute
	Database TABLE.column

	ELCODE_BCD
	ELEMENT_GLOBAL.elcode_bcd

	Global Scientific Name
	ELEMENT_GLOBAL.gname_id

	Concept Reference Citation
	ELEMENT_GLOBAL.concept_reference_id

	Name used in Concept Reference
	ELEMENT_GLOBAL.concept_name_id

	Classification Status
	ELEMENT_GLOBAL.d_classification_status_id

	Inactive checkbox
	ELEMENT_GLOBAL.inactive_ind


	Primary Name checkbox
	ELEMENT_GLOBAL_REF.primary_scientific_name_ind6

	Scientific Name checkbox
	ELEMENT_GLOBAL REF.scientific_name_ind6

	Related Standard Elements grid
	ELEMENT_STD_NONSTD_REL – entire table

	Comments about Relationship to Standard
	ELEMENT_GLOBAL.relationship_to_standard_com

	Begin Date
	ELEMENT_GLOBAL.add_to_std_date

	Addition Authorized By
	ELEMENT_GLOBAL.add_to_std_authorized_by

	Origin Comments
	ELEMENT_GLOBAL.add_to_std_com

	End Date
	ELEMENT_GLOBAL.remove_from_std_date

	Removal Authorized By
	ELEMENT_GLOBAL.remove_from_std_authorized_by

	Termination Comments
	ELEMENT_GLOBAL.remove_from_std_com

	Predecessor / Successors grids
	ELEMENT_LINEAGE – entire table

	Parent Species
	TAXON_GLOBAL.parent_species_id

	audit and universal id fields
	multiple


Table 2.  Fields in ENT, EST, and Element References windows that ARE copied during Deep Copy and Shallow Copy (where they differ from rule for EGT)

	Attribute
	Database TABLE.column
	Notes

	National Scientific Name
	ELEMENT_NATIONAL.nname_id
	Copy

	National Primary Name Reference
	ELEMENT_NATL_REF.reference_id
	Copy

	
	ELEMENT_NATL_REF.scientific_name_ind
	Copy

	
	ELEMENT_NATL_REF.primary_scientific_name_ind
	Set equal to Y for copied reference

	Subnational Scientific Name
	ELEMENT_SUBNATL.sname_id
	Copy

	Subnational Primary Name Reference
	ELEMENT_SUBNATL_REF.reference_id
	Copy

	
	ELEMENT_SUBNATL_REF.scientific_name_ind
	Copy

	
	ELEMENT_SUBNATL_REF.primary_scientific_name_ind
	Set equal to Y for copied reference


ENT and EST deep copy – all other fields are copied except Element Subnational ID

ENT and EST shallow copy – all other fields are copied except Element Subnational ID and Subnation.

References copied for different types of element records

When inserting a reference in the target record, set the _ind field to Y if the specified _ind field in the source record = Y.  In any of these insert operations, the reference may already exist in the ELEMENT_xxxx_REF table because more than one indicator can be set to “Y”. Reject record if it already exists in the table, but set the _ind field to Y.

EGT: Insert rows in target ELEMENT_GLOBAL_REF for any reference in source ELEMENT_GLOBAL_REF table with 

classification_taxonomy_ind = Y or 

scientific_name_ind = Y or 

image_ind = Y or 

other_roles not null

EGR: Insert rows in target ELEMENT_GLOBAL_REF for any reference in source ELEMENT_GLOBAL_REF table with 

rank_factor_ind = Y

CAG: Insert rows in target ELEMENT_GLOBAL_REF for any reference in source ELEMENT_GLOBAL_REF table with 

characterization_ind = Y

El. Mgmt: Insert rows in target ELEMENT_GLOBAL_REF for any reference in source ELEMENT_GLOBAL_REF table with 

management_ind = Y

EO Specs: Insert rows in target ELEMENT_GLOBAL_REF for any reference in source ELEMENT_GLOBAL_REF table with 

eo_specs_ind = Y

EO Rank Specs: Insert rows in target ELEMENT_GLOBAL_REF for any reference in source ELEMENT_GLOBAL_REF table with 

eo_rank_specs_ind = Y

ENT: Insert rows in target ELEMENT_NATL_REF for any reference in source ELEMENT_NATL_REF table with 

presence_ind = Y or 

classification_taxonomy_ind = Y or 

scientific_name_ind = Y or 

primary_ind = Y or 

image_ind = Y or 

other_roles not null

ENR: Insert rows in target ELEMENT_NATL_REF for any reference in source ELEMENT_NATL_REF table with 

rank_factor_ind = Y

CAN: Insert rows in target ELEMENT_NATL_REF for any reference in source ELEMENT_NATL_REF table with 

characterization_ind = Y or 

management_ind = Y

EST: Insert rows in target ELEMENT_SUBNATL_REF for any reference in source ELEMENT_SUBNATL_REF table with 

presence_ind = Y or 

classification_taxonomy_ind = Y or

or scientific_name_ind = Y or 

primary_ind = Y or 

image_ind = Y or 

other_roles not null

ESR: Insert rows in target ELEMENT_SUBNATL_REF for any reference in source ELEMENT_SUBNATL_REF table with 

rank_factor_ind = Y

CAS: Insert rows in target ELEMENT_SUBNATL_REF for any reference in source ELEMENT_SUBNATL_REF table with 

characterization_ind = Y or 

management_ind = Y

2.8 Reparenting Element Occurrence Records

Unlinking one or more EO records from one EST and relinking them to another EST can be done through the GUI by using the “Change Associated Element” option under “Tools” on the EO working list menu bar.

2.8.1 Procedure

1. With one or more EO records highlighted on the EO working list, select Tools – Change Associated Element.

[image: image29.png]File View List | Tools Help

O-Z-& Fnd crier

ery ulder
Current working | &

D [ELCODI| 9 Survey Site

Ethronium akicum
Ethronium akicum

imted viaby |
[Notanked [ |
[Notanked [ |
g

271852 PMLILOUGTD Ethionium albicum ‘Whie Dogtoothvilet Verfied estant [viabilty ot assessed)
271787 PMLILOUTD Egthionium albicum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
272126 PMLILOUTD Egthionium albicum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
272200 PMLILOUDTD Egthionium albicum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
273189 PMLILOUDTD Egthionium albicum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
28790 PMLILOUOTD Egthionium albicum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
287961 PMLILOUOTD Egthionium albicum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
301080 PMLILOUDTO Egthionium albicum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
302999 PMLILOUOTO 12 Exptorium abidum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
307978 PMLILOUOTD 25 Expthorium abidum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
15678 PMLILOUTD 19 Expthorium abidum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
317139 PMLILOUTD 26 Expthorium abidum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
327767 PMLILOUTD 14 Ethorium abidum ‘Whie Dogtosthvilet Verfied estant [visbilty ot assessed)
328546 PMLILOUOTO 23 Expthorium abidum ‘Whie Doatosthvilet e il e f

12 of 85 records selected dheynolds Modiied mango 1172072002 715FM




2. Element Find window open, restricted to subnational results. Search for an element and select an EST from the results (multi-select is disabled). Click OK.
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3. Summary window appears. (Print works!  The report is sent to your default printer.)
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In the case shown above there were no EOs previously associated with the new EST.  Therefore, the updated EO Number is the same as the original EO Number. However, if there are EOs, the EO Number of the EOs being reassigned are updated to the next available number. The changed numbers appear in boldface.
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4. The working list is updated with new Element name and EO Number, as is the EO detail record. The associated Source Feature(s) are also relinked to the new EST.

2.8.2 Points to Remember

1. The application will not prevent you from reassigning EOs to an EST for a different Subnation.  This may be a concern in multijurisdictional databases.

2. If EOs from more than one jurisdiction are being switched to a different element, the relinking must be done in batches, subnation by subnation.

2.9  Higher Classification (for Central Users)

This section to be written…

2.10  Lineage Tracking (for Central Users)

This section to be written…

3 Biotics Mapper

3.1 Creating Features

3.1.1 Create a New Element Occurrence Representation with a single Source Feature

1. From the BIOTICS menu, choose Input/Edit. 

2. When prompted to Select a palette:, choose Element Occurrences.
3. Prior to creating a new EO Rep, a source feature must be created.  You cannot create an EO Rep without having first created a source feature.

a. In the Element Occurrences window, select the appropriate source feature to digitize.

b. Notice the title of the View has changed to Input/Edit – Element Occurrences – Source (Point).
c. Once in Input/Edit mode, you may change the appropriate feature type by:

i. Placing your cursor over the view and holding down the right mouse button.  A drop down menu will appear from which you can choose the appropriate feature type; or

ii. From the Input/Edit menu, choose Element Occurrences and select the appropriate feature type.

4. Turn on or add any themes from the Navigator 
[image: image33.png]


 that are necessary for digitizing.

a. If you would like to add a theme that is not available in the Navigator, add it using the Add Theme button [image: image34.jpg]


.  Be cautioned however, that you should not use the Add Theme button to add themes available in the Navigator.  When certain themes are loaded from the Navigator, tables are automatically joined to them.  This join will not occur if you add the theme using the Add Theme button, which may then result in an error during calculation of spatial attributes.  Therefore, you should never use the Add Theme button to add themes available in the Navigator.
5. Zoom to the location of your EO using the Zoom By tool [image: image35.jpg]


.  For digitizing, you must be at a scale greater than or equal to that of your base map (i.e. 1:20,000 is a larger scale than 1:24,000)

a. Zoom By is a Navigator tool that enables users to easily jump directly to a specific place on the map using coordinates, id numbers, or features in themes. Zoom By entries can be customized by the Mapper Administrator.

6. Draw a source feature.

7. In the Create New Feature (Source) window, click Finish.

8. In the Select Element window, enter search criteria to select a single element.

a. Click the List Elements button

b. Select the appropriate element and click the OK button. 

9. In the Create Source Feature window, complete all data entry on the Identifiers and Mapping tabs.

a. On the Identifiers tab, check the box next to Create EO Representation from Source Feature
b. Click the OK button.

10. In the Create New Feature (EO Rep) window:

a. You may choose to check the box next to Defer Calculation of Spatial Attributes.
b. Click Finish to complete the generation of the EO Rep polygon.

11. In the Create Element Occurrence window, review the data on all tabs and click the OK button. 

12. Click on the Close Input/Edit button [image: image36.jpg]


to leave Input/Edit mode when you are finished your mapping session.

13. If prompted to calculate deferred attributes, choose All Features from the drop down list and click OK.
14. Click on the Close Input/Edit button again to post your edits.

3.1.2 Create a Source Point Feature/EO Rep using X,Y Coordinates

1. From the BIOTICS menu, choose Input/Edit. 

2. When prompted to Select a palette:, choose Element Occurrences.
3. In the Element Occurrences window, set the editable theme to Source Point. 

4. Click the Coordinate Entry button [image: image37.jpg]


 

a. The default projection is displayed in the Input Projection box. You may want to change the input projection if you have coordinates in a different projection or coordinate system (such as, Latitude/Longitude).

b. To change the input projection, click Change.

c. In the appropriate box(es), type in the first set of coordinates.

d. For example, if you selected Latitude/Longitude under "Input Projection", you will type the coordinates in the Latitude and Longitude boxes.

e. If you want the coordinate boxes to clear after you add a point, select the Clear After Add checkbox. If this checkbox is not selected, the coordinates you enter will not be cleared.

f. Click Add to add the point to your view.

5. In the Create New Feature (Source) window, click Finish.

6. In the Select Element window, enter search criteria to select a single element.

a. Click the List Elements button

b. Select the appropriate element and click the OK button. 

7. In the Create Source Feature window, complete all data entry on the Identifiers and Mapping tabs.

a. On the Identifiers tab, check the box next to Create EO Representation from Source Feature
b. Click the OK button.

8. In the Create New Feature (EO Rep) window:

a. You may choose to check the box next to Defer Calculation of Spatial Attributes.
b. Click Finish to complete the generation of the EO Rep polygon.

9. In the Create Element Occurrence window:

a. Choose an appropriate Estimated Representation Accuracy from the drop down list on the Rep Details tab.

b. Populate other data as available on the Rep Detail and Rep Extent tabs.

c. Click OK.

3.1.3 Using Copy Theme to create a Source Feature

1. From the BIOTICS menu, choose Input/Edit. 

2. When prompted to Select a palette:, choose Element Occurrences.
3. Prior to creating a new EO Rep, a source feature must be created.  You cannot create an EO Rep without having first created a source feature.

a. In the Element Occurrences window, select the appropriate source feature to digitize.

b. Notice the title of the View has changed to Input/Edit – Element Occurrences – Source (Point).
c. Once in Input/Edit mode, you may change the appropriate feature type by:

i. Placing your cursor over the view and holding down the right mouse button.  A drop down menu will appear from which you can choose the appropriate feature type; or

ii. From the Input/Edit menu, choose Element Occurrences and select the appropriate feature type.

4. Turn on or add any themes from the Navigator 
[image: image38.png]


 that are necessary for digitizing, including the theme from which you would like to copy.

a. If you would like to add a theme that is not available in the Navigator, add it using the Add Theme button [image: image39.jpg]


.  Be cautioned however, that you should not use the Add Theme button to add themes available in the Navigator.  When certain themes are loaded from the Navigator, tables are automatically joined to them.  This join will not occur if you add the theme using the Add Theme button, which may then result in an error during calculation of spatial attributes.  Therefore, you should never use the Add Theme button to add themes available in the Navigator.
5. Zoom to the location of your EO using the Zoom By tool [image: image40.jpg]


.  For digitizing, you must be at a scale greater than or equal to that of your base map (i.e. 1:20,000 is a larger scale than 1:24,000)

a. Zoom By is a Navigator tool that enables users to easily jump directly to a specific place on the map using coordinates, id numbers, or features in themes. Zoom By entries can be customized by the Mapper Administrator.

6. To set your copy theme, while your cursor is over the view, hold down your right mouse button and from the drop down menu, choose Set Copy Theme
a. In the Set Copy Theme window, choose the theme from which you would like to copy the feature.  Only those themes which contain the feature type you are currently using ( i.e. point, line, or polygon) and are in your view's table of contents will be available.  Therefore, if you are editing the Source Point theme, only point themes will be listed.  This goes for lines and polygons as well.  So if the theme from which you wish to copy is in your Table of Contents, but not listed in the dropdown list, check to make sure you’re editing the correct theme.
b. With the white arrow, click on the feature you want to copy. You may only copy ONE feature at a time, otherwise multiple features will be made into one source.
i. If the feature is a polygon, click inside the polygon. If the feature is a line, you may have to clip it to the appropriate length by following the directions on the screen.

c. In the Copy and Paste Selected Features window, click on Finish.
7. In the Select Element window, enter search criteria to select a single element.

a. Click the List Elements button

b. Select the appropriate element and click the OK button. 

8. In the Create Source Feature window, complete all data entry on the Identifiers and Mapping tabs.

a. On the Identifiers tab, check the box next to Create EO Representation from Source Feature
b. Click the OK button.

9. In the Create New Feature (EO Rep) window:

a. You may choose to check the box next to Defer Calculation of Spatial Attributes.
b. Click Finish to complete the generation of the EO Rep polygon.

10. In the Create Element Occurrence window, review the data on all tabs and click the OK button. 

11. Click on the Close Input/Edit button [image: image41.jpg]


to leave Input/Edit mode when you are finished your mapping session.

12. If prompted to calculate deferred attributes, choose All Features from the drop down list and click OK.
13. Click on the Close Input/Edit button again to post your edits.

3.1.4 Create an EO Rep comprised of Multiple Sources

A separation distance is the amount of intervening area that determines whether Source Features of an Element should be grouped as part of the same (complex) Element Occurrence Representation (EO Rep), or should be considered as discrete Element Occurrences. 

Separation distances will be provided in the EO specifications for the Element. For species, distances are provided for intervening areas of unsuitable habitat, and for suitable habitat that is not known to be occupied. For communities, distances are provided for intervening areas of different natural/semi-natural communities, and cultural vegetation.  The purpose of specifying values for separation distances is to achieve consistency in the manner in which occurrences of the same Element are defined and mapped in different jurisdictions.

In the absence of EO specifications providing separation distances, minimum values have been recommended.

See also: EO Data Standard, Section 4
1. From the BIOTICS menu, choose Input/Edit. 

2. When prompted to Select a palette:, choose Element Occurrences.
3. Prior to creating a new EO Rep, a source feature must be created.  You cannot create an EO Rep without having first created a source feature.

a. In the Element Occurrences window, select the appropriate source feature to digitize.

b. Notice the title of the View has changed to Input/Edit – Element Occurrences – Source (Point).
c. Once in Input/Edit mode, you may change the appropriate feature type by:

i. Placing your cursor over the view and holding down the right mouse button.  A drop down menu will appear from which you can choose the appropriate feature type; or

ii. From the Input/Edit menu, choose Element Occurrences and select the appropriate feature type.

4. Turn on or add any themes from the Navigator 
[image: image42.png]


 that are necessary for digitizing.

a. If you would like to add a theme that is not available in the Navigator, add it using the Add Theme button [image: image43.jpg]


.  Be cautioned however, that you should not use the Add Theme button to add themes available in the Navigator.  When certain themes are loaded from the Navigator, tables are automatically joined to them.  This join will not occur if you add the theme using the Add Theme button, which may then result in an error during calculation of spatial attributes.  Therefore, you should never use the Add Theme button to add themes available in the Navigator.
5. Zoom to the location of your EO using the Zoom By tool [image: image44.jpg]


.  For digitizing, you must be at a scale greater than or equal to that of your base map (i.e. 1:20,000 is a larger scale than 1:24,000)

a. Zoom By is a Navigator tool that enables users to easily jump directly to a specific place on the map using coordinates, id numbers, or features in themes. Zoom By entries can be customized by the Mapper Administrator.

6. Draw a source feature.

7. In the Create New Feature (Source) window, click Finish.

8. In the Select Element window, enter search criteria to select a single element.

a. Click the List Elements button

b. Select the appropriate element and click the OK button. 

9. In the Create Source Feature window, complete all data entry on the Identifiers and Mapping tabs.

a. Click the OK button.

b. Return to Step 6 and repeat until you have created all Source Features.

10. When all your Source Features are created:

a. Zoom out so all your sources are visible on the screen. 

b. Use the Generate EO from Source Feature(s) tool [image: image45.jpg]


to select all the sources either by clicking on each one or clicking and dragging a box around them all. 

c. In the Generate EO from Source Feature(s) window, click Next when the number of Source Features Selected equals the number of Source Features in your EO Rep

11. In the Create Element Occurrence window, review the data on all tabs and click the OK button. 

12. Click on the Close Input/Edit button [image: image46.jpg]


to leave Input/Edit mode when you are finished your mapping session.

13. If prompted to calculate deferred attributes, choose All Features from the drop down list and click OK.
14. Click on the Close Input/Edit button again to post your edits.

3.1.5
Create a Sub-EO

1. Create a source feature that will be completely within the EO Rep of the occurrence that you want to make a parent EO.  

2. In the Create New Feature (Source) window, click Finish.

3. Select the ELCODE for the new source feature to be the same as the surrounding EO Rep and click OK.

4. In the Create Source window, check the box to Create EO Representation from Source Feature. 

5. Click OK. 

6. At the Confirm Sub-EO window, click Yes to make the EO a sub.

7. In the Create Element Occurrence window, click OK.  The General tab will list the parent EO id.
3.1.6   Create a Parent-EO

Note:  When you create a parent EO for an existing principal EO, the Parent/Sub relationship is not created until deferred attributes are calculated.  Deferred attribute calculation for Parent/Sub relationships is affected by the “Update Parent-EO-on-Recalc” System Setting.   If your program uses Sub-EOs, your System Setting for standard Biotics data entry should be “PROMPT”.  Please see your Biotics Mapper Administrator for more information. 

1. Create a source feature that completely surrounds an existing EO Rep polygon for which you want to create a sub EO.

2. In the Create New Feature (Source) window, click Finish.

3. Select the ELCODE for the new source feature to be the same as the contained EO Rep and click OK.

4. In the Create Source Feature window, check the box next to Create EO Representation from Source Feature.

5. Click OK.

6. In the Create New Feature (EO Rep) window, click Finish.

7. In the Create Element Occurrence window, click OK.

8. Set the editable theme to EO Reps.

9. From the Input/Edit menu, choose Calculate Deferred Attributes.  This step should be done after creating each parent EO – do not wait until the end of your edit session.

10. In the Calculate Deferred Spatial Attributes window, choose Current Feature Only from the drop down list and click OK.
11. In the Confirm Sub-EO window, click Yes.
3.1.7 Create a Source Line Feature Following the Outline of an Existing Polygon

1. Choose the line palette from Input/Edit mode.

2. Set the interactive snap tolerance by clicking and dragging a circle using the Set Interactive Tolerance tool [image: image47.jpg]


.

3. From the Input/Edit menu, choose Set Snapping Options.

4. In the Snapping Options dialog:

a. Choose the theme you wish to snap to from the Themes in View and click the right arrow to move it into the Selected Themes list.

b. Set the snap mode to Vertex.

c. Leave the snap Method at Closest.

d. Click OK
5. Choose the Create Line from Dots tool [image: image48.jpg]


 to digitize your line source feature along the boundary of the polygon.  As you digitize, vertices should snap to vertices WITHIN THE SNAP TOLERANCE in the polygon feature.  If  your vertices are not snapping, you may need to zoom in closer or increase your snap tolerance (See Step 2).

6. When you finish digitizing your line, click right and choose Complete Shape from the popup menu to connect the dots.

7. Within the Create New Feature dialog box, click Finish.

8. All subsequent features you create will be in the current snapping environment.  From the Input/Edit Menu, choose Set Snap Options and set the Snap Options radio button to No Snapping to turn snapping off.

3.1.5 Create a Source Polygon Feature Adjacent to and In between Two Existing Features

1. From the Input/Edit mode, choose the Source Polygon palette.

2. Use the Draw Line to Append Polygon tool [image: image49.png]


 to draw your source polygon feature adjacent to ONE of the existing source polygon features and overlapping the other source polygon feature.

3. At Create Feature, click the Edit button.

4. Use the Split With Features tool [image: image50.jpg]


  to select the overlapping source polygon feature.

5. From the dialog, choose the EO.Source polygon theme as the theme with which to split features.

6. Choose Yes when prompted to proceed with keeping the split feature.

7. Your new source polygon feature will be split into pieces.  Use the Pointer tool [image: image51.jpg]


 to select the piece of the new source polygon feature overlapping the second feature, and hit the Delete key on the keyboard to remove it.

8. In the Create New Feature (Source) window, click Next and then Finish.

3.1.6  Create a Duplicate Source Feature From an Existing Source Feature

1. From Input/Edit mode, choose the palette matching the feature you want to copy (Source Line, Source Point or Source Polygon).

2. Click right in the view to bring up the popup menu and choose Set Copy Theme.

3. Set the Copy theme as appropriate to EO.Source Point, EO.Source Line or EO.Source Polygon and click OK.

4. Click on the source feature you want to copy using the Copy and paste tool [image: image52.jpg]


.  Note:  you may only copy one source feature at a time.   If you select more than one feature with the copy-paste tool, you will end up with a multi-part source feature, which is incorrect according to the methodology.
5. Within the Copy and Paste Features window, confirm the Copy From and the Copy To locations and click OK.
6. At Create New Feature (Source), click Finish.
3.1.7 Create a Polygon Source Feature from a Buffered Line

1. From the File menu, choose Long Menus in REGULAR VIEWING MODE.

2. Use the Line tool to draw a line which will create the buffered feature as a graphic in the view.

3. From the Theme menu, choose Create Buffers to bring up the ArcView Buffer Wizard.

4. Choose to buffer The graphics in your view
5. Check the Use only the selected graphics box and click Next.

6. Choose the At a specified distance option, type in a distance, choose the appropriate units and click Next.

7. Choose to save the buffers As graphics in the view and click Finish.

8. Use the Pointer tool [image: image53.jpg]


 to select the buffer (the graphic currently selected is the original line).

9. From the Edit menu, choose Copy Graphics to copy the buffer.

10. Delete both the original line and buffer (both graphics) from the view by selecting them and hitting the Delete key on the keyboard.

11. From the Biotics menu, choose Input/Edit and choose Element Occurrences and the Source Polygon Palette.

12. From the Edit menu, choose Paste to paste the graphic into the view.

13. From the Edit menu, choose Copy and Paste Graphics to make the graphic into a feature in the EO Source Polygon theme.

14. Within the Copy and Paste Selected Graphics window, confirm the From theme and the To theme and click Finish to create a source polygon.
At Create New Feature, click Finish.

3.2 Deleting Features

3.2.1 Delete an EO Representation

1. From the BIOTICS menu, choose Input/Edit. 

2. When prompted to Select a palette:, choose Element Occurrences.
3. In the Element Occurrences window, set the editable theme to EO Representation.

4. Use the Delete Feature(s) in Any Theme tool [image: image54.bmp] to select a single EO Rep, or click and drag a box to select multiple EO Reps.

5. If the Select Designer Features window displays, choose EO Representations.
6. In the Delete Element Occurrence window, highlight the EO Rep(s) to be deleted and click OK.

7. Click Yes in the Delete Selected Items confirmation window.

8. At Delete, choose the appropriate option and click OK:

a. If you want to delete the source feature(s) as well as the EO Rep feature, choose Unlink and delete the Source(s). 

b. If you want to keep the source feature(s), choose to Unlink only, do not delete the Source(s).
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9. Deleted features will be archived in the archive shapefile, and the tabular records in Biotics Tracker will be deleted and moved to the deleted schema.

3.2.2 Delete a Source Feature

1. From the BIOTICS menu, choose Input/Edit. 

2. When prompted to Select a palette:, choose Element Occurrences.
3. In the Element Occurrences window, set the editable theme to the source feature you want to delete.

4. Use the Delete Feature(s) in Any Theme tool [image: image56.bmp] to select a single Source Feature, or click and drag a box to select multiple Source Features.  Note:  if you want to delete linked source features from a source feature palette, all source features selected in a single operation must belong to a single EO Representation.

5. If the Select Designer Features window displays, choose the Source Feature theme from which you wish to delete features.

6. In the Delete Element Occurrence Source Features window, highlight the Source Feature(s) to be deleted and click OK.

7. I in the Delete Selected Items confirmation window, click Yes.

8. Deleting source features will trigger one of the following scenarios:

a. Deleting all the sources for a linked EO Rep will trigger a delete of the EO Rep as well.  In this case, in the Confirm Cascading Delete window, click Yes to complete the process.  The EO Rep and source feature(s) will be archived and the tabular records in Biotics Tracker will be deleted and moved to the deleted schema.

b. Deleting one or more source features (but not all) from a multi-source EO Rep will trigger a regeneration of the EO Rep feature and the Edit Existing Feature window will display.

9. In the Edit Existing Feature window, click Finish to complete the process and the old EO Rep and deleted source features will be archived and the tabular records in Biotics Tracker will be deleted and moved to the deleted schema.

3.3 Editing Features

3.3.1 Move an EO Representation with a Point Source Feature

Note:  if you want to move a source point feature AND change the Locational Uncertainty type or Areal-Estimated distance, follow procedures for Replacing a Source Feature. 

1. From the BIOTICS menu, choose Input/Edit. 

2. When prompted to Select a palette:, choose Element Occurrences.
3. In the Element Occurrences window, select Source Point as the feature to digitize.
4. Zoom to the location of your EO. You may want to use the Zoom By button [image: image57.jpg]


, also accessed from the View menu. For digitizing, you must be at a scale larger or equal to that of your basemap (i.e. 1:20,000 is a larger scale than 1:24,000). 

5. Use the move point tool [image: image58.bmp] to click on the source point feature and drag it to a new location.  This may take a while; wait until the move arrow [image: image59.jpg]ot g




shows up on the view. 

6. If there is more than one point at the location, a window will display where you will be asked to choose the appropriate source feature.   Choose the correct one and click the Finish button. 

7. In the Move Point Feature window, click Finish.  

8. In the Edit Existing Feature (EO Rep) window:

a. You may choose to check the box next to Defer Calculation of Spatial Attributes.
b. Click Finish to complete the regeneration of the EO Rep polygon.

3.3.2 Edit EO Reps by editing the Polygon or Line Source Features

1. From the BIOTICS menu, enter Input/Edit mode and select Element Occurrence and the EO Representation palette.

2. Use the Zoom By button [image: image60.jpg]


 to zoom to the EO Rep or Source Feature you want to edit. 

3. Use the Edit Feature(s) in Any Theme tool [image: image61.jpg]


 to select the feature to edit.

4. Within the Select Designer Features dialog box, choose the appropriate selection theme and click OK.

5. If there is more than one feature in your selection theme, an Edit Feature(s) window will display.  Choose ONLY ONE feature to edit and click OK.  Biotics Mapper will lock the feature for editing.  If you are unsure, you may highlight a feature and click the Flash Shapes button to see the feature highlighted on the View.

6. Within the Edit Existing Feature dialog box, edit the feature by selecting the appropriate editing tool (see Online help topic: Editing the newly created shape).
Deleting Multiple Vertices from a line or polygon: Use the Delete Multiple Vertices tool [image: image62.jpg]


 to create a polygon or rectangle around the vertices you wish to delete. You may do this multiple times to delete non-contiguous vertices.  If you wish to delete to a point which lies in-between vertices, you must first create a new vertex using the Vertex Edit tool [image: image63.jpg]


 and then use the Delete Multiple Vertices tool to delete the unwanted vertices.
Deleting or adding a Single Vertex: Use the Vertex Edit tool [image: image64.jpg]


 to delete a vertex by placing it over the vertex you wish to delete and hitting the delete key on the keyboard, or to add a vertex by clicking at the location of the new vertex.

Reverse Line Direction: The Reverse Line Direction tool [image: image65.png]


 lets you reverse the direction of a selected line

Reshaping a Polygon: Use the Reshape tool [image: image66.jpg]


 to draw a polyline to reshape the existing polygon.   You must overshoot when starting and ending your new polyline.  Because the Redefine tool forces you to overshoot, you may end up with extra vertices, which you can delete using the Vertex Edit tool [image: image67.jpg]


. 

Creating a Hole in a Polygon:  Use the scissors tool [image: image68.jpg]


 to draw a polygon to create a hole.

7. When you are satisfied with your edits, in the Edit Existing Features window, click Finish. Biotics Mapper will archive the old shape.
8. If you are editing a source feature that is linked to an EO Rep, Biotics Mapper will regenerate the EO Rep and another Edit Existing Features window will display for the EO Rep.  Click Finish.

3.3.3 Replace a Source Feature with a New Shape of the Same Feature Type

Note:  if you want to replace a source line or polygon feature AND change the Locational Uncertainty type, Conceptual Feature Type or Areal-Estimated distance, you may choose to follow procedures for Replacing a Source Feature.

1. Select the source polygon or line feature you want to replace using the Edit Feature(s) in Any Theme tool [image: image69.jpg]


. 

2. The location will most likely be occupied by more than one feature. At Select Designer Features, select the SOURCE feature to be replaced.  

a. If there is more than one feature selected, choose the feature to be replaced from the Select Feature(s) window.  If you are unsure, highlight the source feature and click on the Flash Shapes button to flash the shape on the view.


3. Biotics Mapper will lock the feature for editing and the Edit Existing Feature box will display. The total No. of Features Digitized will = 0.  Now create your new polygon:

a. To digitize the new source feature, select the appropriate from the tool bar and digitize your shape and continue with step 4.

b. To copy a feature from another theme, right-click on the mouse and choose the Set Copy Theme option from the pop-up menu 

c. You then are prompted to select the theme which contains the feature you would like to copy.  Only those themes which contain the feature type you are currently using ( i.e. point, line, or polygon) and are in your view's table of contents will be available.
d. Use the Copy and paste tool [image: image70.jpg]


 to select the feature you want to copy.   Do not copy more than one feature at a time and if you are copying from a regions theme, make sure there is only one feature in your selected region.
Note:  If you are using one of the EO.Source feature themes as your copy theme, the Select Features(s) window may display. SELECT THE FEATURE YOU WANT TO REPLACE. If you are not sure which is which, click on the Flash Shapes(s) button and the selected feature will flash at you.  You may only use an EO.Source feature theme as a copy theme if the new feature and the replacement feature do not completely overlap. If they do, you will get a Feature Replacement error message and you will have to cancel the entire operation without completing it. 
e. The feature you just copied becomes a graphic (it is easier to see if you turn off the copy theme).

4. Click the Replace Button [image: image71.jpg]


 and Biotics Mapper will replace the original source feature with your new one.   The EO Rep polygon will still have its original shape.

5. The Total number of Features Digitized now = 1 in the Edit Existing Features window (source feature). Click Finish and the application will go through the process of archiving the old shape and making the new shape into a source feature.  The EO Rep theme will be turned on if it's not already and when processing is finished the new shape's vertices will be highlighted. 

6. The Edit Existing Feature window (EO Rep) will display.  Click Finish to re-generate the EO Rep using the new source feature.  The "new" source feature will have the same feature_id, locational uncertainty type and conceptual feature type as the "old" source feature.

7. Since the new shape takes on all the information from the old shape, make sure you query the source with the red query tool [image: image72.jpg]


 and change the Conceptual Feature Type and Locational Uncertainty if necessary.

3.3.4 Replace a Source Feature with a Source Feature of Another Feature Type

1. From the Biotics menu, choose Input/Edit. 

2. Choose the Element Occurrence palette and click OK
3. Choose Source feature type of the new source to be created and click OK.

4. Use the Zoom By tool [image: image73.jpg]


 to zoom to the EO Rep whose source you want to replace.

5. Create your new source feature by digitizing or by using a copy theme.

6. At Create Source Feature, do NOT check the box to Create EO Representation from Source Feature.

Note:  if you want the new source feature to have the same tabular data as that of the source feature which is being replaced, at this point in the process you would need to go into Tracker and do a record copy, prior to replacing the source feature in Mapper.  Spatial attributes and fields that are required when creating a Source Feature (Conceptual Feature Type, Locational Uncertainty Type) are not copied/overwritten when a record is copied. Any nonrequired data that has been entered in the target record, including rows in the Observations grid, will be overwritten.
a) Find the newly created Source Feature in Tracker

b) From the Tools menu, select Copy Data From.
c) The appropriate Find window opens. Search for and select the original source feature record from which you want to copy the data, and click OK
d) Verify that the data has been copied from the original record to the newly created source feature record, prior to continuing.
7. Query the existing EO.Rep with one of the query tools [image: image74.jpg]


.  

8. Click on the Sources tab and click the Replace button.

9. At Generate EO From Source Feature(s), the Number of Selected Features will reflect the number of source features currently linked to the EO Rep.  Hold down the Shift key and from the view, click on the source feature you want to replace to unselect it.   

10. Click on the new source feature to select it.  You may alternatively, click on the Unselect All button and then, from the view, reselect all the sources you want linked to the EO Rep.

11. When you have the correct set of source features selected, in the Generate EO From Source Feature(s) window, click Next.

12. At Edit Existing Feature (EO Rep), click Finish.

13. At Delete, choose to Unlink and delete the source(s) and click OK.  If you want to keep the source feature, choose to Unlink only, do not delete the source(s).
3.3.5 Add New Source Feature(s) to an Existing EO Rep

1. Create your new source feature(s) by digitizing or by using a copy theme.

2. At Create Source Feature, do NOT check the box to Create EO Representation from Source Feature.

3. Use one of the Query tools [image: image75.bmp] to the EO Rep to which you will add the new Source Feature.

4. If the Select Designer Features window displays, choose EO Reps and click OK.

5. If the Query Element Occurrences window displays, highlight the EO Rep to which you will add the new Source Feature(s) and click Details.

6. In the Query Element Occurrence window for the EO Rep, choose the Sources tab and click the Add button. 

7. Select the new source features from the view and in the Generate EO Representation from Source Features window, click Next.

8. In the Edit Existing Feature (EO Rep) window, click Finish.
3.3.6 Remove Source Feature(s) from an Existing EO Rep

1. Use one of the Query tools [image: image76.bmp] to the EO Rep to which you will remove Source Feature(s).

2. If the Select Designer Features window displays, choose EO Reps and click OK.

3. If the Query Element Occurrences window displays, highlight the EO Rep to which you will remove Source Feature(s) and click Details.

4. In the Query Element Occurrence window for the EO Rep, choose the Sources tab and highlight the source features you want to remove from the list of source features.

5. Click the Remove button. 
6. At Delete, choose to either Unlink and delete the source(s) or Unlink only, do not delete the source(s).
7. In the Edit Existing Feature (EO Rep) window, click Finish.

3.3.7  Cut a Hole in a Source Polygon Feature Using an Existing Feature

1. From the Biotics menu, choose Input/Edit.
2. Choose Element Occurrence
3. Within the Select Designer Features dialog box, choose the Source Polygons theme.

4. Right click and choose Set Copy Theme from the popup menu.

5. Choose the EO Source Polygon theme as the Copy theme and click OK.

6. Click on the source polygon feature that will form the “hole” using the Copy and paste tool [image: image77.jpg]


, which should be active

7. In the Copy and Paste Features window, click Edit to make the menus accessible.

8. At Copy and Paste Features, edit the resulting graphic by deleting anything additional to the polygon that will form the “hole”.

9. From the Edit menu, choose Copy Graphics to get the small polygon into the copy buffer.

10. From the Copy and Paste Features dialog, click Cancel.

11. Choose the polygon tool and draw your new source polygon feature. 

12. At Create New Feature (Source polygon), click Edit.

13. From the Edit menu, choose Paste. 

14. Using the Pointer tool [image: image78.jpg]


, hold down the Shift key and select the new source polygon feature so that both the new source polygon feature and the pasted graphic are selected.

15. From the Edit menu, choose Subtract Graphics to create the hole in your new source polygon feature.

16. If the small graphic still exists, select it with the pointer tool and hit the Delete key on the keyboard to delete it from the view.

17. In the Create New Feature (Source polygon) window, click Next and then Finish.

18. At Create New Feature (EO Rep), click Finish.
3.3.8  Replace a Polygon with a Single Polygon Created from Two Polygons in a Copy Theme

1. Within Input/Edit mode, right-click on the mouse and from the pop-up menu, choose Source Polygon.

1. Create and activate a filter in both the EO.Rep polygons theme and the EO.Source polygons theme so that no polygons in the view are overlapping the source feature and EO Rep you want to edit.

2. Select the source polygon feature you want to replace using the Edit Feature(s) in Any Theme tool [image: image79.jpg]


.

3. Click right in the view and select Set Copy Theme from the popup menu.

4. Choose the appropriate theme as the copy theme.

5. Make the copy theme active and select the two polygons that will form your new source polygon feature using the ArcView select tool [image: image80.jpg]


.  

6. From the Edit menu, choose Copy and Paste Features.

7. Within the Choose Features dialog, click Select All.

8. When prompted, choose Yes to dissolve interior lines.

9. Click the Replace button [image: image81.jpg]


 to replace the least rectangle source feature with the new shape(s).

10. Edit the resulting source polygon by using the polygon tool to digitize a polygon that fills in the space between the disjunct pieces and overlaps the edges of each existing piece (do not leave the new source feature as two disjunct shapes – if you want to use two disjunct shapes, each shape must be its own source feature).
11. Select all the pieces of the edited source polygon feature using the Shift key and the Pointer tool [image: image82.jpg]


 .

12. From the Edit menu, choose Union Graphics.

13. When you are satisfied with your edits, within the Edit Existing Feature (Source) dialog, click Finish.

14. Within the Edit Existing Feature (EO Rep) dialog, click Finish.

15. At Create Element Occurrence, choose an Estimated RA value from the dropdown list and click OK.

3.3.9 Edit a Boundary Shared Between Adjacent or Identical Source Polygon Features

2. Within Input/Edit mode, right-click on the mouse and from the pop-up menu, choose Source Polygon.

3. Select the Source Polygon feature for one of the source polygons, using the Edit Feature(s) in Any Theme tool [image: image83.jpg]


.

4. Within the Select Designer Features dialog box, choose EO.Source Polygons.

5. If the Edit Feature(s) window displays, highlight the ONE feature to edit and click OK.

6. When the Edit Existing Feature window displays, using the Vertex Edit tool [image: image84.jpg]


 (which should already be the active tool), hold down the Shift key and click on the adjacent feature (or if the two features are identical, click on the feature again) to additionally lock the adjacent or identical feature for editing.  Both features should now have their vertices displayed.

7. Click outside of both features to unselect them both (be sure not to click on any other feature either – if this is not possible, you may have to cancel the process and create a filter and start over).

8. Click on the shared boundary.

9. Make your edits along the shared boundary using the available edit tools.

10. When you have completed your edits, in the Edit Existing Feature (source) window click Finish.

11. Note that only the EO Rep polygon for the ORIGINAL feature you selected for editing will be regenerated from the new source feature.  A Biotics text window will display listing the feature id of the EO Rep that will not be regenerated.  You may click Print to print this information and then Close to dismiss the window.

12. Within the Edit Existing Feature (EO Rep) dialog, click Finish to regenerate the original EO Rep. 

Regenerate the adjacent or identical EO Rep polygon:

13.  Select the adjacent or identical EO Rep with one of the Query tools [image: image85.jpg]


.

14. Within the Select Designer Features dialog, choose EO.Reps (Polygons).

15. Within the Query Element Occurrences dialog, select the EO Rep to be regenerated and click on Details.

16. Within the Query Element Occurrence dialog, click on the Sources tab and click the Add button.

17. Within the Generate EO From Source Feature(s) dialog, click Next.

18. Within the Edit Existing Feature (EO Rep) dialog, click Finish.

3.4  Working with Managed Areas and Sites

3.4.1  Create a multi-ringed Managed Area or Site by digitizing on screen 

NOTE: to use a copy theme, see procedures below.

1. Choose the Managed Area or Site Palette

2. Draw the first polygon using the polygon tool [image: image86.jpg]


 .

3. Click the Edit button on the Create New Feature window.   

4. To draw additional polygons, Choose the polygon tool again [image: image87.jpg]


  and draw your additional polygon(s) and continue with the next step.  If your additional polygons come from a copy theme, follow steps a and b:

d. Set your copy theme by right-clicking on the view and choosing Set Copy theme from the dropdown menu and choosing your copy theme from the list of themes.  If you are not sure of the scale of your copy theme, please check the metadata or see your GIS Administrator.
e. With the white arrow (the copy and paste tool [image: image88.jpg]


 is active), click inside the polygon feature(s) you want to copy.  

5. Click Next in the Create New Feature window.

6. Click Finish in the Create New Feature window.

7. Give the Managed Area or Site a name in the Create Managed Area (or Create Site) window and click OK.

3.4.2  Create a multi-ringed Managed Area or Site using a Copy Theme

Note:  if you are going to use a copy theme, it is most efficient if your copy theme is a unioned shapefile or a regions coverage.

1. Choose the Managed Area or Site Palette.

2. Right-click on the view to and choose Set Copy theme from the dropdown menu.

3. Choose your copy theme from the list of themes.  If you are not sure of the scale of your copy theme, please check the metadata or see your GIS Administrator.
4. With the white arrow (the copy and paste tool [image: image89.jpg]


 is active), click inside the polygon feature you want to copy.  

a. If your copy theme is a regions coverage or a unioned shapefile, you can click on the feature to copy and you will copy multiple polygons at once.

b. If your copy theme is not regions/unioned, then click on the first polygon.

5. At Copy and Paste Selected Features, click on Finish.

6. Give the Managed Area or Site a name in the Create Managed Area (or Create Site) window and click OK.

7. If your Managed Area or Site is complete, you are finished.  If you still need to add additional polygons, follow the procedures for “Adding a New Tract to an Existing Managed Area or Site”.
3.4.3  Add a New Tract to an Existing Managed Area or Site

1. Choose Input/Edit from the Biotics menu.

2. Choose the Managed Areas or Sites palette.

3. Select the MA or Site feature to edit with the red edit tool [image: image90.jpg]


.

4. If the Select Designer Features window displays, choose Managed Area or Site, as appropriate.

5. When the Edit Existing Feature window displays, draw your new polygon(s) using the polygon tool  [image: image91.jpg]


 (you will have to select it from the drawing tools menu in the toolbar, as the default tool is a rectangle [image: image92.jpg]


).  To use a copy theme, follow a and b:

a.  Set your copy theme by right-clicking on the view and choosing your copy theme from the list of themes.  If you are not sure of the scale of your copy theme, please check the metadata or see your GIS Administrator.
b. With the white arrow, click inside each polygon feature you want to copy.  If your copy theme is a regions coverage or a unioned shapefile, you can click on the feature to copy multiple polygons at once.  

6. Using the pointer tool [image: image93.jpg]


, select ALL the polygons included in the MA/Site.  You may select the polygons by clicking and dragging a box surrounding or intersecting the desired polygons.  Alternatively, you may select one polygon, then hold down the shift key and click on the remaining polygons.   Small black boxes will appear around EACH of the selected parts.   Note: You must be careful that no other shapes in the editable theme are selected.  If they are, they will be included as part of the multi-part shape.   You may shift-click with the pointer tool to unselect shapes you do not want included with this feature.  

7. From the Edit menu, choose Union Features.

8. Click Finish in the Edit Existing Feature window.
3.4.4  Remove a Tract from a Multi-ringed Managed Area or Site

1. Select the Managed Area or Site feature to edit with the red edit tool [image: image94.jpg]


.

2. If the Select Designer Features window displays, choose Managed Area or Site, as appropriate.

3. Choose the Multi-Vertex delete tool [image: image95.jpg]


.

4. Draw a polygon around the tract you want to delete.

5. Click the Finish button on the Edit Existing Feature window.
3.4.5 Remove a Tract from a Multi-Ringed Managed Area or Site and Add it to Another existing MA or Site

1. Select the Managed Area or Site feature from which you wish to remove a tract, using the red edit tool [image: image96.jpg]


.

2. From the Edit menu, choose Copy Features.

3. Choose the Multi-Vertex delete tool [image: image97.jpg]


. 

4. Draw a polygon around the tract you want to delete.

5. Click the Finish button on the Edit Existing Feature window.

6. Select the Managed Area or Site to which you wish to add the tract, using the red edit tool [image: image98.jpg]


.

7. From the Edit menu, choose Paste.  Another copy of the entire copied MA/Site will be copied to the View.

8. Choose the Multi-Vertex delete tool [image: image99.jpg]


.

9. Delete the portions of the copied MA/Site which you do not want by drawing a polygon around the unwanted portions.   The remainder of the previously edited MA/Site will still remain. 

10. Using the pointer tool [image: image100.jpg]


, select ALL the polygons included in the MA/Site to which you just added the tract.  You may select the polygons by clicking and dragging a box surrounding or intersecting the desired polygons.  Alternatively, you may select one polygon, then hold down the shift key and click on the remaining polygons.   Small black boxes will appear around each of the selected parts.  Note: You must be careful that no other shapes in the editable theme are selected.  If they are, they will be included as part of the multi-part shape.  You may unselect polygons by shift-clicking with the pointer tool.

11. From the Edit menu, choose Union Features.

12. Click Finish in the Edit Existing Feature window.
3.5  Use a Digitizing Tablet with Biotics Mapper

1. Turn on the digitizer before you boot the computer.   

2. Enter Biotics Mapper and Input/Edit mode and choose the appropriate feature palette. 

3. Use the Zoom by button to zoom to the quad you wish to register. 

4. Choose Input/Edit>Register Map. This will bring up the Digitizer Setup dialogue.
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5. You can leave the default error limit at 0.004, however, be aware that ArcView will not let you register the quad unless your RMS error is smaller than that in the box.   See your Biotics Mapper Administrator to determine what is an acceptable error limit.

Note: When you're using the digitizer with ArcView/Biotics Mapper, the digitizer puck will emulate the mouse. You can toggle the digitizer between absolute mode and relative mode. By default, after you register, you are in absolute mode and the puck is correlated with real world coordinates according to your registration. When in relative mode the puck behaves just like the mouse and you can use it to access ArcView's menus, buttons and tools.   See the ArcView Help for more information.   Use your digitizing tablet driver to configure the following functions on your digitizing  puck:

· left mouse click

· left mouse double click

· toggle between absolute and relative mode

· right mouse click

· drag

· drop

To register a quad using ArcInfo tic files:
6. Add the ArcInfo tic coverage to your view from Navigator. 

7. Choose Load from the Digitizer Setup Dialogue (Input/Edit>Register Map). 

8. From the Load Control Points dialogue, set the List Files of Type drop down list to INFO and then navigate to the info directory in which the tic file is stored and choose the appropriate tic file from the list on the left.   All tics in the file will be loaded into the Digitizer Setup menu. 

9. Find the tic # of the lower left corner of the quad and select it from the Digitizer Setup list. Make sure you click on it because it will not be selected if you just scroll to it using the cursor. 

10. Digitize the lower left corner of the quad from the digitizer using the button configured as a left mouse click.  An asterisk should appear to the left of the tic coordinates in the Digitizer Setup box. 

11. Digitize the remaining 3 corners as in steps 10 and 11. 

12. When you've digitized all 4 corners, the RMS error will show up at the bottom of the Digitizer Setup box.   See your Biotics Mapper Administrator for an acceptable RMS value.   If you are satisfied with your RMS, click on register and skip to step 18. If you are not satisfied, you may attempt to improve your RMS by re-registering any or all corners of the quad.

To register a quad using UTM tic marks:
13. If there is a registration file saved for your quad, click on the load button and navigate to the appropriate file.

14. Digitize a minimum of 4 tics from the digitizer, clockwise starting from the upper left corner (only if this is how your tic file was stored).   One line for each tic will appear in the digitizer setup box. 

15. Type in the correct x and y coordinates for each tic. Be sure to type in the coordinates in the same order that you digitized the tics.  For UTM coordinates, the x-coordinate is always in the X00,000 range and the y-coordinate is in the X,000,000 range.

16. Once you've typed in all the points, the RMS error will show up at the bottom of the Digitizer Setup Box. See your Biotics Mapper Administrator for an acceptable RMS value.   If you are satisfied with it, click register and you are now ready to digitize. 

After Registration:
17. Zoom to your EO on the screen, making sure the entire area of the feature is in the view screen. Since you will be digitizing from a registered 1:24,000 scale map, it does not matter what scale your view screen is at. 

Choose the appropriate tool and digitize your source following the Creating a New EO Rep instructions, using the tablet instead of screen digitizing.

Biotics Administrator

3.6 Extensibility:  The “Optional Fields” of Biotics Tracker

New fields can be made visible on the user interface through the Dynamic Tabs function in Biotics Administrator. This function allows custom fields to be placed on tabs that appear at the end of the row of standard tabs on a detail window. It allows the tab name, field name, data type, field size, and other characteristics to be specified through the interface shown below.
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Configuration of new tabs and fields will be done by a system administrator based on specifications received from users.

The table below shows the “granularity” at which optional fields can be configured.  For example, since the Element Tracking and Characterization detail windows are substantially different for communities versus taxa, it is possible to add a “optional” tab to a community EGT that will not appear on a species EGT, and vice versa.  However, on other types of detail windows, a new tab will be visible on all records of that type.  For example, if Botany requests the addition of a field to EGR that only applies to plants, the new tab containing that field will show up on animal and community EGR records as well.  However, security can be configured by user group for each extensible tab to make its contents read-only or to hide the data completely (e.g., zoologists would see the tab but it would appear empty).

	Detail Window

(Defines the granularity for which extensibility can be configured)
	Parent Table

(Extensible table should link to this table)

	ELEMENT TRACKING – G - SPECIES
	TAXON_GLOBAL

	ELEMENT TRACKING – G - COMM
	COMMUNITY_GLOBAL

	ELEMENT TRACKING – N - SPECIES
	TAXON_NATIONAL

	ELEMENT TRACKING – N - COMM
	COMMUNITY_NATIONAL

	ELEMENT TRACKING – S - SPECIES
	TAXON_SUBNATIONAL

	ELEMENT TRACKING – S - COMM
	COMMUNITY_SUBNATIONAL

	
	

	ELEMENT RANKING – G 
	ELEMENT_GLOBAL_RANK

	ELEMENT RANKING – N 
	ELEMENT_NATIONAL_RANK

	ELEMENT RANKING – S 
	ELEMENT_SUBNATL_RANK

	
	

	ELEMENT CHAR – G - SPECIES
	TAXON_GLOBAL*

	ELEMENT CHAR – G - COMM
	COMM_CAG

	ELEMENT CHAR – N - SPECIES
	TAXON_NATIONAL*

	ELEMENT CHAR – N - COMM
	COMM_CAN

	ELEMENT CHAR – S - SPECIES
	TAXON_SUBNATIONAL*

	ELEMENT CHAR – S - COMM
	COMM_CAS

	ELEMENT CHAR – L - COMM
	COMM_CAL

	
	

	ELEMENT MANAGEMENT
	ELEMENT_MANAGEMENT

	
	

	EO SPECS 
	EO_SPECS

	
	

	EO RANK SPECS
	EO_RANK_SPECS

	
	

	ELEMENT SITE
	ELEMENT_SITE

	
	

	ELEMENT ECOREGION – G 
	EL_GLOBAL_ECOREGION

	ELEMENT ECOREGION – N 
	EL_NATL_ECOREGION

	ELEMENT ECOREGION – S 
	EL_SUBNATL_ECOREGION

	
	

	EO ECOREGION
	EO_ECOREGION

	
	

	ALLIANCE ECOREGION
	ALLIANCE_ECOREGION

	
	

	ELEMENT GROUP
	ELEMENT_GROUP

	
	

	ELEMENT OCCURRENCE
	EO

	
	

	SOURCE FEATURE
	SOURCE_FEATURE

	
	

	MANAGED AREA
	MA

	
	

	SITE
	CONSERVATION_SITE

	
	

	SCIENTIFIC NAME
	SCIENTIFIC_NAME

	
	

	REFERENCE
	REFERENCE

	
	

	CONTACT
	CONTACT


* Due to the way Linnet programmed the characterization windows, the species characterization extensible tables cannot be related to ANIMAL_CAx or PLANT_CAx.  Instead, they must be related to the TAXON_x table.  This means that if a cascading delete is set up in the database, the characterization record delete will not result in the extensible characterization information being deleted.  If a new characterization record is created after a delete, it will pick up the old extensible information if it exists in the database.  This can be avoided if the HDMS_TABLE_ACTIONS table is used for deletion instead of cascading delete constraints.

3.7 Audit Tracking

This section to be completed…

3.7.1 Record Maintenance

3.7.2 Attribute Maintenance

4 Biotics Exchanger

This section to be completed

The GoTo button (blue arrow) opens a “mini” working list that allows you to view all the records available in this window and to jump to any of them, not just First – Previous – Next – Last. 





The blue arrow button also performs the “Goto Record” function.





“1 of 16” indicates that 16 EST records exist for the Element and we are currently viewing the first one in the list (arranged alphabetically by subnation).  The arrow keys allow you to move to the first, previous, next, or last record. These choices are also available on the menu bar under Edit - GoTo.








� If you encounter any field in HDMS where these functions do not work, try right-clicking to open the dropdown edit menu.


� One exception is that it is not possible to directly move from an EGT record to the related higher classification unit (genus or parent species for a taxon, and alliance or formation for a community) or vice versa.


� The minimum data that you will have to fill in is the Global Scientific Name, Name Used in Concept Reference, Concept Reference Citation, and Classification Status. Primary Scientific Name Reference Citation may also be filled in.  These fields will NOT be overwritten during the copy.


� If Biotics Mapper is in use, several additional fields in the EO, Source Feature, Managed Area, and Site windows will not be copied.  A complete list of these fields is available. 


� If Biotics Mapper is in use, it is not possible to create a new EO or Source Feature record through the Biotics Tracker GUI.  In that case, EO or Source Feature copy can only be done between two already existing records, and no fields entered in or calculated by Biotics Mapper will be copied. 


� Always set to N’ for copied reference
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